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ABSTRACT

This thesis presents the system for On-Off Switch System and Status Report via
Internet to test electric equipment controlling and camera web cam through internet that
comtains with electronic board module together with MCS51AC2 and web cam. This can
control close & open system for electric equipment for 4 point, each point not mare than
1200 watts and able to show picture on internet. From the result of this test, this system
can control electronic switch and present the result from Web cam through this system as

ohjective.
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WWW Server

WWW Server {ISP)

5QL

Fubeyatupluny
HTML

Database Server

quit 21 mwyneasdad iy

221 fawtlaznouaes ad Lie WGy

mraclitin Bad o Gu i Budasiidlunondisil

2.2.1.1 unasdayanteiiulad

SulaiRadiugine’ damueaimeiidwmsafuiuwefidiAmamanmEung
Sumaiifvogudiuledilé fnedsmasfamefiviwididuiuladenesldsnnigianmeying

windulen&Eufl (Windows NT) Ald uasasdasimadonsdiadalisunandameriasi fiada
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A ¢ a v . v AHG & € v | \ ad A A U Sy a e
aaxfaee fiesaniwhwhidwiuledacaut TunsdifeTasnaniumaHiuldvn fifdnms
ulmdidufasilronduriiudwieshidenlfisu TUsunsn Purveyou HTTP Server a4
#071% European Microsoft Windows NT Academic Center (EMWAC) lusunsudvleduas
13% OReily and Associate ¥iaih fssuulfiidmsgfiindfiaraldiiudivinefiflu NSCA hup,
Apache Wi

vl v G f v v g G Yvd a ‘v A Swifly A v
FAduwroaiuledarinaiadumarasawdulindulediu dal#lgauduq shlan
;7 H .l: [ 7] 1 1 L ] I:l'.
sansndhangdaaafifiu i lwdulsdiulddomat Bumesasdningn ONN awfuergficiuled
WWW.Cnn.com Lﬂuﬁu
2.2.1.2 Wsunssduunaeed
a € £ Y a € £ o a4 & 8 G 1
Hulisunsavdegardwa il lumadhg dad T By aedlagivmaiiAvagluiulad
1o dhodneaalusunsadivurmwet ffilianiinaaliiuldwd 16w Netscape Navigator 910
UF%N Netscape Communication W& %11 5UWN T8 Microsoft Internet Explorer 31 nu3 % v
1'[ cﬂde G ‘1':”' ..,~[ “I‘u
ulasgard Wudu Falusunsudvusnmeddulngiueeiounuiollrunsidulasd way
| ﬂ' £ [ » ws sl dl [l )
wannnselfifeniumaninduledlan udr waallsunsuieflenusmnaniueg wu vims

amnedidmmsafing mafwndiaga mslawmalusunsadhy FTP dudu

2.3 Web Server wac Web Browser

Fwian 2 dfimenaienmdiletuluneuiiae Web Server uay Web Browser

Web Server wiullsunsniogluiniaadiminaiimindlumsiudiose uasims
VasnonaudasslIiesoslelnfioud viaesdnhiiwlisursad W lumssmmdiues

Web Browser iulunsufiatindasilolndiaud fuhilumededayalumsiastagdy
uasashemadagadulaedn duumeefadenaudlalumanasgmsasfufide mw HTML

wararamEIsoulaIn HTML Wluiduviawienans i i€

2.4 laswa
A w g v AAae & a g
18wy (Home Page) aumnafonihusneasdiumarimaeifigliinduae ifinaswy
4 a . A o d X
wafimadhiugaduledlen TanmanBouealoumn iy uasdnbfidhassSuledahoaumans]d
“w £ € P8 v o . » A w 4 & A a
venduwudasdnsgasmui wuimsludalethe uenainfiudamelulanmaniion flaadinsday

fudumwadug Suswauenne e



2.5 mefudetioya ludumeduia
dathaia i wenemaanBsamsiuussmedslaynswinladiaudiudmnef deled
LOUANN http://www test.com ﬁa.‘:tﬁmnﬁﬁmuslu%umau@haq Gt

1 fieleaeudRuifion URL uifida hip:/mwww.test.com vawaifiasims
request HTTP wianifurwshiefiagimemsluiisendua’ Tcp

2. gor§ TCP fasuasBatmematuifiaylef (P address) lowdamsiad (Query)
TghdniEmnaiutds URL fafudine$ DNs

3. asBnedhansfiedasuuisfiontudinelmems Tasfimsesseumsesnnt
FVUALALNITSUN5 1) Handshaking Tuudnzusininaialtudlaldnisloniny
Saymszmnalenendiudneifimnudatioldlunsdifdoys majann TCP anus
fayananduwininagon udRuswiaifnneaensSauasiung Wuiwinng
ot wanhi 1 Tagumemauastayadygumfinmifte synchronize Mty

4. TCP wwaaininalufunwedlafluawefauiudumasloftoiufioguasled
Foloaiouduandmantussivg Thiutayauasadiialuth Ethernet

5. {nsi009 Ethernet axvindaudiug Snuacdawininaluiy router Tﬂu*ﬂ’uagjﬁum‘m
dumsmelunmiuin rouer semidumaaiindfeRiiussavinmgige Wod
wininaaan ffudMnaitlamms

6. Hatadininaiudr 1o TCP vaadivinaiumeniasds Acknowledgment
uisleaioudilduuinnaud ddmnamemebildiulusesnnfinminld
Inlnawudanfiodn Srelileaouddostelyinseuawas TCPP 10udivinas
Janemma awlachwifa TCPAP winusiasuinineifiudaya Seasmfaviuloaioud

7. TCP at¥nm7ds Request 1/Els HTTP 1@5wiiat Saaznsvawsaenan danwwany
MiurasuidMietardsivd HTML wiaaturlwddeyalUtuawed TCPP
whwingstufumemandulileaeud (reliidmffiemeidadss
@haed)

8. Phugauduininelayaromeavgneis maldlafeislaaioud uasummediay

b L3 L [
NITNLYVDYALRILAAILUNIIR a\lﬂamu@]



2.6 IP Address

dasvnlwruuiedateduneiinellislanea TepP Wusnmrgmlumsdadioys
%msﬁmiﬁmuﬂwwuLa'uﬂ'i:ﬁwﬁqﬁ\laiéwﬁuiﬁﬁmauﬁama‘?nnl,ﬂ%mﬁﬁm‘n%auﬁuarﬂmsnu
whnthamnaasiiaegndunh P Address wiovanuas P Tnafipuiwudugavesiiee
4 oiedaniedamantqn i 202.44.192.43 Faatluusiazgearinng 8 dadnilusiasyaed
enléaud 0 B 2°- 1= 255 windu T Wmasnimmensneiay P WsueosnasRauma Il
Fomsodiudmatmaailtdiua

FruilafimsfeduniamanuneFiiulzadeanfme ftedaasadridunn o
warLAmashen Suifudinsvavenaiay IP Ussdmiasau Internet Network Information Center
(InterNIC) ¥a389AnT Network Solution Incorporated (NSI) ﬁ"fjl.’m%ﬁ e ﬁw'fjam?ﬂuwiﬁmﬁ
sifraduardnimismuivmifdudhamsBunedida (ntemet Service Provider: 15P) (I

vrzmenefiogwaemiems) Rlidasamnoay 1 Wnigldiag

46 .
2.7 #L0Wlad (Domain Name System: DNS)
5 A & u [ v a A A £ A ¥ A a
nmalfmneas P gafludiaudoug wmstedefenanumaiudaneiaoiu swfitadefa
Alden waralifamnduauldaodafinwanisnmiedslmmeaae P wulvsifidenh
X
Domain Name System (DNS} 940
Siinad dumafiomswaouiowy P Adudiesiduisnmsunumnoae P
202.12.97.1 fAmasnann@ondiudelowmndie kiulkkuacth umiednsnasmainaiiidensh &

. i a v A
Hued seiwrhfumsutasntalowsius ifwsnemy © Snfind

2.8 HTML (Hypertext Markup Language)

HTML hipuuusnaspwulumssiaamindulaefinmn HTML dummfihedanisGen
wandls leomasnsnlfiamcug lunmsahadumslosld HTML 1nlaofifugmag lugufin
<..> Inufidnemslduin 2 el

1. Winfiqaanduiaaugm
G A
2. whinidiene

v ] : v nl 3 4 ) A ° [

dethawfin HTML flardasfiqniuduuazqadugn 1n <b> uay </b> faiiumsili

dhsnwsiudvun tusdeu <bs> [Taenms uazlilstasme <b/s wdrrenasaznatads

L0 ] [ 4 U
Fammanamnzlaifl <bs Tedaliiassimdansfuganmsusasdmuiives ustléda



HTML #iftwsdaitnn A deuldnluuds bidasdnwmedugn wu <hrs audunsshadufu
WLaH WD <p> aufiunraudamivsidiudi
TunmBen HTML Smdnmssd
1. Sndulwdasdasdeuudin <himl> ueshe Wdaediaidade </htmi>
2. gipan <htmi> xdipafiu <heads...</head> Fameluufin <heads aelaufindidiu
Faidos safuidotiontin 1 mdde <ites...</title>
3. 69N <head>..</head> udnsfhudmans <body>..</body> TTaudaudeiin
fasmsaiiauaadustuiaudin <body>...</body> 'ﬁ

panlassehougmivasivdioriiduues

<Html>
<Head>
<Titde> %aﬁlm
</title>
</head>
<Body>
lﬁwwﬁwuﬁmwa
</body></Html>

qufl 2.2 LmuTﬂ‘saﬂ%'Nﬁujmmo‘lwéLa'nﬁLﬁmma

2.8.1 drdadndudlelumentrslasms
& Tags) PiFmmierdiSuuaasstsznauliUdeeiamnetioondt ‘< sudeta
s uarlahodoniommeinnndt > dudwiimiiudanatoyaseg ﬁujwunﬁn
T lusdsmasesfifuusadulngaedug ssiudnemdidniuuagiusduin Tasshia
?Jmmé"nsaq‘l,um%mwmu "< LLﬂb’éhﬂﬂﬁWﬁ.d%ﬂﬂmﬂ%adwmﬂ “o/>" Fhathamds
1. Vaeng)
gﬁuuuﬁwéh <!>
maHedmsnamgllsunannietiBaues fsdunfdmiuudhigemildnmuinm
mawvhezlsar vianwanduneie findaamssenifimaiulsunsssenndedarmudiduuas

Unnpegudawismalulisunsuesiidauesas i mnguussnmldsunauduumme’
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2. fndacEnd
@Jtmuﬁwé'fa <Html>...</html>
fds <Heml> Swehdfdndulumad@elisunmioriduuas uasids </himl> aufu
FdauderhRugalunmarfidauoa
3. daurheaillsunan
E‘IJLLU'LIﬁTE"ITJ <Head>...</head>
fdle <Hoad> {iuends 7ildmmadaealudmiiiviodassesndasfidauon uay
meluwndassismdsdananddmilda Ml <utle> ddlinfa </title> UaE </head>
4. vuedanm udiwhealtsunavis lafiaus
gﬂuuuﬁwé"e <Title>...</title>
mhaduauiiudwinsaidaratands viedaraswdlonfidauns Sefanrmnelu
dwgaﬂmﬂﬂgw%aLLﬁmwa‘\,uﬁ'mﬂaﬂmﬁﬂm% (Title Bar) vadltunsanivuamige? udaclsiuaadlu
dzasmuaanaraslLsunIN UL Iget
5. shudiomuslisunx
gﬂuuumél’d <Body>...</bady>
mdsludmdiomeasihunmdiiuidefianey dmmauanona wiiimga$ foay
vssnevulinuidnyaasplmumatinehsn faglufumamean

dhaphalsunm

<Html>

<! Commenti>

<Head>

<Title>test</title>
</head>
<Body>

Croate the

example homepage
</body>

</html>

zﬂﬁ 2.3 fhuLﬁam'anﬂmn‘m
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2.9. PHP (Personal Home Page)

2.9.1, "1 PHP Appsls
PHP famim script aehavilefifiu server-side script Faazvnamaluila server udadems
LeRanaINEl browser 48961 Client wasmanang hudfadiu script 7 embedded U HTML &n
fe
PHP unw§ wan script language ﬁwé"whaq wﬁuasﬂu‘lﬂéﬁﬁ‘undw 634 (script)
u,amaﬂiﬂﬂﬁmmﬁuﬁqLLﬂi-qmmé%a FhothaaanmandUdieu JavaScript, Perl Wudiu Snwow
929 PHP flusnshannnmnsesududug Aa PHP Idsumswaniuszaanuwuusn e lfamlums
shaenansuuy HTML Tsensnsnsaaunsnvdautlasiamlnedalusid dniudanannh pHP fu
mmﬁﬁun’h server-side %38 HTML-embedded Scripting language Lﬂutﬂéadﬁaﬁﬁﬂﬁm‘ﬁﬁﬂ
viksfne M imansnanas NSy Dynamic HTML ¥oenai sy anBnomannau
PHP 1unswsundifuafausniud aa. 1994 Taugqu Rasmus Lerdorf sinxn 16
Tunsusaiidangas lunmvanndammud sy fhnofusha wmﬁ"aﬁma%%umqﬂ%uﬂu
o 5 SinWannddyreaaiiu 4 uas 384 5 Aaqm Zeev Suraski UALAM Andi Gutmans
TnvnuefifiuEninedssnns 16 Sulasn (domains) 714 PHP inansninamnasaudvmag
domains '711% PHP \lﬁﬁ http://www.php.net/usage.php
Iu@ouuIN PHP easnan Personal Home Page udidasn lddendalsassmungino
%89 GNU %aﬁluﬂaqﬁwuad PHP wfuelaanan Hypertext Preprocessor Tau@uashas 989 PHP
s dmiRan ey adues PHP $0fie hitp//www.php.net
2.9.2 ANNENNTINTDINYY PHP
1. mwiawivmihfedion fun PHP @a Perl, Microsoft Active Server Pages
(ASP), Java Server Page (JSP), uat Allaire ColdFusion
2. §wdsuidfieuntn PHP fummdun wahimaswuhnmn PHP S ldiey
wangsthadiasialuil
3. fiaumsnusgeananaassunalivaisdiu hits Tuusiaziu
4. sshofiedafiuvaielsnneasyudayaatiingu MySQL, PostgreSQL, mSQL,
QOracle, Informix, Sybase WarAaNT0 | Open Database Connectivity Standard
(ODBC) Wafindaffundeiniwiyutoyates Micosoft
5. Lidaaiuar ldhelunslfinasnsomnilvaa PHP 1dan htp://www.php net

lahisaasduenlgnglan
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6. BumdunclFiy lawawiztumimm C, C++, Perl, uay Java DU
7. o PHP Wumeneseuu fifenslaedbida s fewlauns
E 4
2.9.3 MIGAGMNI41 PHP
Tuftimmesasiiueiag Windows XP Professional
1. Download AppServ2.5.2 91 http://gear.kku.ac.th/krunapon/178375/tools htm|
2. ynmafinda AppServ loumsnanu Next Ttidoue aunssimsfiedasdadeuion
3. nesaumadadialasmadladuumieaiuay sy URL A hiwp:/ocalhost 1510173
awldwhdumadausnslugnif 2.7
w a -~ :; G = L [ ) d 4 Asda
wEnfafedasiaduuiaousaswunitlonnned AppSer daflulasnmasidlann
vig3 www agialulvd PHP Amehamaadiu3ldlesmma? c/AppServiwww
» 1
2.9.4 Anugiasdwnuafiumm PHP
2.9.4.1 mIunInddeny PHP Wwanins HTML
. o w d aqw a . v =
maanraunsnédamm PHP 1dlnensld PHP tags defiliifiadunsteuentiidmd
Huerderasnis PHP fiagluianas HTML m3ld PHP tags duansnsnvi ldmanaguuoy

L1 ] :
Savin it

<? Php ..7» (XML style}

<? ... 7> (short style)

<script language='"php’>...</script> (Script style)
<% .. %> (ASP style)

4 Y
1fl 2.4 naunInendinn PHP

i Pa ] a w - [ 1 3

wuufinasldfe XML style asainmantoriauldfunnidivenes (Sever inviy
ganadaariulnstisaam PHP ,

aanseeediunim PHP Bmelwenas HTML mwnfidaimslalauf PHP tags

pRaseyadufy HTML tags sedathaiu
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<html>

<head>

<titla>My Homepage</title>

</head>

<body>

<h1><?php echo "Helle World!"; 7></h1>
</body>

</htmi>

7t 2.5 mrnaendslunmmw PHP Bmelwenars HTML

e

P »

v AU seawch < Fovorbes WP Meda £ (e ih I

R L R U I :
it D masatioige B

JGocger | ] w00 Gigse T @
ke ) WebmabU - Logn ] Wekome oty Yahoo! @) mu- - S ) Audndw =

Hello World!

Blpore . - S ocal iranet

honinis

d v o 4 Py
“i.ﬂl’l 2.6 Naawﬁ'mmﬁﬂumm PHP 1’1ﬂ1EJ1HLaﬂﬂ'l‘i HTML

2.94.2 gluuuMW PHP uazendl

2,94.2.1 Comments

Comments hmm PHP ngﬂtmummn comments 1’1«%1&1 C++ uaenm XML

AR dl LY | 1 oA A B | o 1
Comments {lifathidingre Wigfidenmdagswmltsunadhlalusunsa fathswas comments

<! -- File: hello.php (comments in xml styla} -->

// this style of comment is suitable for a short comment that is not over one line

* to write comments more than one line, you may want to use this style

‘gﬂﬁ 2.7 Comments 14n1s PHP
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2.9.4.2.2 Varlables (#uys)
. - 17 A [ { | 5 t.é 1 u
Variables 38 ik fa foySmunlflfumidioys Literals Aatoyafomanmnifiusmasi
g . ) o s x
WUy $salary iudauds 20,000 tu Literal 35n13muadiaudsluniw PHP asdinaududae

WiIamving $ udmudaetauasiougs fhathamsidiuls

Example 2: variable php
<?php
$salary = 20000;
echo “Your salary is $salary Bahts.”;
>

radniAlamnmsSlsunaadaod

9Uf 2.8 uamon3 14 Variables

DQBc s o @ e Seach Dfavrkes @ Meds £ [0

§ Addrass ﬂ hitp:/flocalhost:81 {def suk varisble. php
- g

i tinks @} WebmaiKli - Login ] wekcome to My Yahool ﬁm-iﬂ-ln.ﬁ.m"ﬁ

Your salary ts 20000 Bahts.

#]0one e = - 8 Local itranet

3Ufl 29 wadwdannliids Variables

1 dl. = dl | z
ﬁWl‘m'nﬂm‘lﬂﬂ “View" URY AaNN "Source” AILILWLINUUDNMIYBY file “variable.php”
] [ y A ] | 7]
fiu “Your salary is 20000 Bahts” Iifédsvosniw PHP Famunuenad Server Wulasua
. o ol 1 1 [ -] G- j . : A LY
adrasguudufacudlain Browsers Infudiudiomeas file mflautumue
[}
2.9.5 PHP flumsswivan v
w fGa ¢ P ~ ¢ . oA a ¢
mswinaaindfiae midswdaniesesnanfiamas Client WnTasnanfiamay Server
L Lo 7] 1 3 : nl -

dmiumm PHP viuananindeuldadninanldiasleaimnbidasdadlugalon audunanm

anadumwadwiumaswinas lWa [esehshuae
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- va Yoy X

misedumaiaiwlvas inawimaihemldduiunausalui

- mesEnaaSndvsuswvan ing

- My@euaedUd PHP dvdumsiwinaning

- MTNAERLSLLLM AR

7] (4 - oW [ 8
2.05.1 Masiansdudsudnlven lwd
v
myas19TsuuSwlnaatiu Dreamweaver MX asganldlumsadiaefudwiuinlnaadinu
Wndwiudams ndhfiuasdasdathifilwunlde (Code View) Walouldaing

» ¥

Tuduaauusnazdiumsld Dreamweaver MX uvsnwaSuas mdumadwiulvdldammnen

Y
| 1

1 »
8NN Browse WaniWdFisnemsiwlvasuanamiufifimeuwanyu Upload dviuedniiadadu
myswivaniwa
»
2.9.5.2 fuseumsshonadndwivinlvaalwd
1. Walysunsy Dreamweaver MX ﬂﬁmmé File > New axmm{]\lmazﬁan New
A‘ L =] I R r |I: -
Document AusnI¥AANWIL General (dan Gynamic Page > PHP ¥ 1NUUAGN
1) Create TAndulng fileupload.php
2. wrsmwasuasluiumalaanfniioy msert > Form
3 LS o3 1 A
3. fivmenmanidsesedulaansadndhananedimasagnwlumeiadousng
[ 3 174 [ 5 - = o= AI [~
1puamBdulsRunmdsnniuninidenuin <Forms> #1 Tag selector U390k
LR v a A . . a 5
1auaaavamiaenAnilinyg Window > Properties Lilayring laazdan

. I i e e w1 ‘I'a
Properties U W wuaq oA iadio il

Ul 2.10 uamslpasBantwunguanuseuiin <forms>

vdsnmunsna sz U1 1wSaudl¥ednilu Show Code View

(3] Code | [ [ X |

e | Syansdanagldnfi Dreamweaver MX #susnziininlud <Forms>
: , 4 -

QuUTINgeN attribute enctype="mulipart/form-data” #aaydine hama unafudisl

maaunld Form Object wiia File Field
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4. wn3n Form Object 1A File Field asma lnaSamdmuliimuaguicanifive
File Field l& umsﬂﬁnﬁmy} Window>Properties Lﬁaﬂimg‘lma:ﬁan Properties

.! o i 1 [ ¥ [ 7 [ A:
T W vuedalutay File Field Name i “File” simeaudensusiadi

M9 2.1 Ltam'lﬂazﬁanﬁmuﬂqmauﬂé’mm Form Object #4i¢ File Field

fuedlensien Adiiua
File Field Name File
CharWidth 50

Uit 2.1 uaaslenzfanfmuanmaniians Form Object in File Field

5. Wnan Form Object 96 Button asne luma Tumdsnniuliimunnmianiidees
Button latn17nand Ny Window>Properties Wayn ﬂgiﬂ avfan Properties

3 L) e oot :
it uagmani@es Button sadia il

mefl 2.2 usenlnovienimuannieanifias Form Object #fle Button

fveslassdon afifmua

Labal Upload

Action Submit form

71l 2.12 uamalpasfanrimusnmienti@ieas Form Object 1% Button
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- - .
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a I [ i s !
6. AANTIN Show Code View uatansdainaqléafi Dreamweaver MX a9t
whundllAeamsinm Form Object 9 File Field uat Button &dlunainsiag

| 3 i
ATURN

<html>

<head>

<title></ title>

<meta http-equiv="Content-Type" content="text/html; charset=windows-874">
</head>

<body>

<form action="upload php" method="POST" enctype="multipart/ form-data" name="fmupload"
<input name="File" type="file"value="" size="50">
<input name=""type="submit” valne="upload">
</ form>

</body>

</html>

gﬂﬁ 2.13 ugenldinuas g fileupload.php

7. Thnlwg fileupload php
2,9.5.3 maduuandld PHP dwfumsdwlvanlvd
Sumavinlifaniumsdnlda PHP dmivianslndfgninmatuanmdnafdly
WlnSavaddolramo Frimunly
SupaumaBenaeiud PHP dwsumzsnlvaning
1 ﬁ%a'[wéma'?ﬁm%’uﬁ'mﬁu‘lwé‘[mUﬂﬁnﬁmg} Site > Site Files SELTINQWAL Files 7
ST eI AR TVIAUINTE LAY Files aAnuhENI
Unngunylsiadnidan New Folder unerimmniolndinodiiii Upload Files'
2. Dalusunsa Dreamweaver MX aANiY File > New atumng lnazdan New
Document s WieAn wt General an Dynamic Page > PHP yEniueAn
1u Create TuinidulwWg upload.php

] v »
3. @Anfjs Show Code View wimubiRanlfada s udume

75169
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<?php

// upload full path (Detect path automatically)
If {!defined(UPLOADDIR')) define(UPLOADDIR' (dimame(_FILE_)."/ Upload Files"));
g

o . A L1 [ [T T | [ ) [V V- | £l X A:

Sanfin: <2php rvustalndnadmiudafulnddmindafiulndfaninantunluii

Frmniiiuninesio “Upload Files * amasimenmildlndinafvesan indvasdiwieiuay
#aal permission Aasnsndendaoldisu vinduseuuufifnm tinux Wiimua permission du

777 Witardauiudelwdieas 13 lueéusenaid “UPLOADDIR”

J = L [ %
31.!11 2.14 LEFNNTELuaa3Ls PHP swsumsawivaning

<?php
//checks if file uploaded
If {is_ uploaded _ file{$_FILES[File'][tmp_name){
CEpTRL
Eonldila¥ is_ uploaded_ file(t 9a4PHP dwiuasnasvridimadnlven dviollauans
dounindfignifiuti$rnsm $_FILES[File][tmp_name) Wetuiiargridlamemacadafia

wnaeenanaamninyeninen Wdazdssmuendudu TRUE

J = L “
3Uf1 2.15 usnamsiBnsedUd PHP dwiumsinlneatna

$File_tmpname = $_FILES|'File"]["tmp_name"];

$File_ name = $_FILES([‘File"]["'name™];

$File_type = $_FILES|['File"] ['type’];

$File_extension = substr($File_ type.(strrpos{$File_ type,"/"H+1));

$File_size = $_FILES['File"]['size"];

eyt

§_FILES|'File''tmp_name’] s mwnfifioannininandiio nénmuwdnes
§ FILES(‘File'I['name’] fuuisfidionnnsiwlnanifude igasoiswinantan

o A -~ [ [-3 - ‘A' LY .I
$_FILES[File’] ['type’] datnuniidiennmssnwlnsafiusiaasiwdisninansun

3Ufi 2.16 usmemaTereRUR PHP dwiumaininas s
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//checks if file maved successful
¥ { move_uploaded_fila($Fila_tmpname, {UPLCADDIR . */" . $File_tmpname}) )
echo "<br> File uploading successful.”;
)
else|
echo “<br> File uploading failure.”;
}
afne:
wnfimasnlnan Wfaving wdaniWdgnam Temporary) IWfiWawestiadiulndlanden
'l-z?ﬁﬁu move_upload_file(}
lomathu WS aasuanaiani “File uploading successful.”

]
-

dladheWadeiladu move_upload_file)) idiSaasuansdania “File uploading faiture.”
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. M uMUIUULUBWGNT (Index addressing)

~ o s W N

. M3 weuviadia (Bit addressing)

2.14 lofiwed RTL8019AS

2.14.1 AMANIAYDY RTLIO19AS

AteNTAYas RTLB019AS fimuatduaddoluil
1. {lw PQFP #¥ia 100 pin
2. lafléiriu software RTL8O1Y
3. 309%ulvne PaP auto detect (1WWieu RTLB019AS)
4. W% Ethernet 1T uay IFEES02.3 10BaseS, 10Base2, 10BaseT
5. Software 1479 NE2000 16 vhaefle slot 8 T ua 16 fin
R AT jumper Uay jumperless
7. e jumperless $995UM MUY Plug and Play 999 Microsoft
8. ansnanfuitaifu Ful-Duplex Ethernet iva #8849 bandwidth g3aa3ulnue

power down 1# 3 16 Aa

- T§U sleep
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- Power down twswimmeluiduay
- Power down Wiaamya (halt) wimmalu
9. ﬁﬂaﬁﬁumﬁuiagaﬁwﬁw (built-in data prefetch function) Lﬁamsﬁmu&ﬁ
UseAvBn A siu
10. 58950 UTP, AUI & BNC auto-detect {iaw1¢qu RTL8019AS)
1. spa5umiuindalla (auto polarity correction) a4y 10BaseT
12. 58350 8 [RQ lines
13. 38951 16 /O base address watlnua extra /O address fully decode (GYERT
RTLBO19AS)
14, 589%0 16K, 32K, 64K uarlmamadi@ls BROM i 16K-page (snsaiinléia
256 Pages i) 16 K byte/page)
15. 7095u¢h§1 BROM disable command WaLlammisuaaisdmdms boot S
18. 7095umuanNdT flash memory WABEM (WWW1LTU RTLBO19AS)
17. § SRAM 16 k byte finsia it (wizqu RTL8019AS)
18. 1% 9346 (EEPROM 64*16-bit) Lﬁu-r'faga resource configuration way ID
parameter
19. sanolsunId blank 9346 WL on board e WimsnsiunsiBamld
20, 78931 4 diagnostic LED pins, MnTnlsunsy outputs e
2.14.2 Mwanduahrluznslafiued RTLE019AS
RTL8019AS iy Ethernet Controller N1 Uuanﬁiaﬁumﬁﬂ.ﬁﬁﬁnh Plug and Play
NE2000 sshsou5uldidamaridn full-duplex UAY power down WRTATUANTLAUNT power
down 1889 3 36y RTLE019AS nanuuuntia ¥ ugunsel network 3¥UU GREEN PC
Tnenawigluiari®u full-duplex @sns0suuazaaty full-duplex Ethernet switching hub wiasru
WU twisted-pair alsifingifstas bandwidth 210 10 Mbps 4 20 Mbps It uddiiae
ﬂrumé’mfiaamﬂuﬁu (contention) 489 Ethernet CSMA/CD protocol Wandat AWari¥u Piug
and Play 189 Microsoft %dﬁﬂﬁ&ﬂﬂﬂﬁadﬁwﬁﬁd adapter's resource configuration %% [RQ,
/O Way memory address 184 WA ld@a1301% Plug and Play wawRissuiaathale MaNaING,
RTL8019AS fhsas¥uoaudi jumper uway jumperless l#ande
RTL8019AS DONULUN MEN3NINATIANL 10BaseT transceiver, BNC WatAUI interface

L [ LT . Lr .'i ) .
1olaodaludi@ (auto-detect) 10BaseT transceiver 818150 UA 98280 (polarity error) Un
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receiving pair {uuudaludd uanmnﬁ”ﬁaﬁaaw'ﬁ‘u 8 IRQ lines Uae 16 I/O base address dwsu
nmﬂﬁ:uu resource configuration simumm Bnene
RTL8019AS ‘a‘aﬁﬂﬁﬁd BROM 18k, 32k & 64k byte uav flash memory interface Y
Warldu page mode FoanasnuiamitednTsLEy 16k-byte Wiwwhuanud) BROM
aM-byte 14 Towién&s BROM disable command dwiStLlaemizurmadr BROM Tiwsasdmiu
UUAMN (9w EMM386, “iav) wisninfiantysunss BROM iaSaGeusaaudidnie
RTLB01OAS 53w SRAM 15091 16 k-byte desauun/iudidamneiumsinusas

Harusnnd1 uasa®ms sourcing was inventory a9 SRAM 1¢ianse

qU# 2.24 Tofind RTLE019AS
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N1S22AKLL NIFHIILASNITIING

3.1 A1

misanuuUiasmMIETrIUde - Jauasmanusnmesindnmszurdwaniiie Tdud
aaniflu 2 du Aa gAra9RIMUeN wardmsadlisunn Tuwgrranstmuguaiszna lude
2 dfia Tud eI IMUANERINT UatdteInda Web Camera

Toemahomasinsdmisiafinm Web Page ?Jaa'q@mé'hﬁ"lﬁm‘%'uu‘mﬂ piadaeu
sudwaeiiindanloadniy HUB Safwinnandlumsdendetoyadnivuedeovtillotwas
RTL8019AS Baifu IC feanumaniaiuqunselifiafndeadadifuuade SAT5102NET e
Mo diuasiy Walinadlidiad on eidsantuasdilidiadinem uatludu
samesinfasdsinduanisuanamumsniiamludiueeindos Web Camera asfimsifunm
T Snadimanminssinsdimwnduanioni Web Page #idvhmaahaliudlulusunsum

AaNAIADS

INTERNET — HUB ——™1 RTL5013AS #- SATS102.NET

COMPUTER [—®] WEB CAMERA

jﬂﬁ 3.1 vfanleazunasassulonTa

3.2 ﬂ']‘Jﬂl;lﬁJ!Jl:laﬂ3ﬂ11ﬂ%1\1klﬂ§1§qqqﬂﬂ7ﬂﬂ‘ﬂ
MIoNUULMAIN TR LR TIIL R - Tauatmomianusdiadimsurduwaaivia
Iaenilfaemaseaaniumssanuuude
1. W lumunugunsaliwihrisufueafilald 4 90

A 8L ¢ | a £ G Yu
2, Lwa‘l“LLN\jﬂ']UﬂNﬂ'lmU\ﬂ“ﬂﬂ’]%ﬂaﬂﬁﬂwq 4 qﬂ N‘]uﬁmuaulﬂastﬁ@ﬂﬂ
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3. WiaiusnsassamntszgndfenueusiadguUnselivilusan LaN 16

4. W lRluem Web Page 1a9gaf A InTasiimmiuImgainday Web Camera

1

nsankuLdaIimuatiaanNTrarNeTmuas uude - Dauarmearudomiaiod

| a f G o .5"[
WU iwmesifia Wimanerulasawiiles

1.

msfiadafuaanfagainmsnfiedefomarimweinaynialoelfnaspums
Fadaw Rs-232 lonlladiues MAX232 ifudlunsssiussnineaniunsuay

unenas blnsesalnsaaa’ MCS-51

- m3lmbenlssnananaaliladnsna MCS-51 wa$ ATBIC51AC2

] 1 W - 1 = A - | ]
. MagandaiussuLBwea iniarmlafiues RTLE019AS Fafiuladfoanuuuniiia

1 lunmfesafassiuruutia®din

. mafiesarussuuiueaiuinaminnfiedalaanRoasHuisuy LAN Wmdis Ri-
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. imase iWoanuuu v Widensaslanldlofiund LM2s75HY Avimvhitsnwsedy

v ‘ll/ a4 a L) o & A a ¢ [ )
wsadiulinah et iiuursssmugulnefiunassisiazillalasided 1 6

" | 7 H
whvitasriumsa Eﬂﬂ Nﬂmﬁam'ﬂﬁmmmﬁu‘m UGIGLI.N\'J’NQT‘I.NIﬂTﬂﬂ ﬁI‘r’lTﬂLﬁﬂ%

3.3 msaanqul.tazn'lsﬂ%"lmuumuqu

3.3.1 madeudidadanlusunsy Kell

a o a v oa w v o ] a a v 8w o . a
HANIINANNTHUIBUUAT 'ﬂumau@}a‘[ﬂﬂﬂﬂ']'iﬁumu‘l‘ﬂ\'ﬂuﬁ-]“TUI'].JTLL”?N Keil n1saau

v
L L] 1 A’ 1 -
Tsunsndae Kiel viudiasinnmoldllade mnsansd imdasahelusdetuwnnouudniing

t:l.dl = 3 nl ] d‘. 13 o d : 1 A o :
MHTYLIEUTU LWNL'EhNﬂHTﬂTL%ﬂ ﬂﬂ“ﬂﬂ.‘ﬁ’ﬂﬂﬁﬂﬂﬂd‘mé LATTHIES TITUNDUAINT HENU

1.

Walusuna Keil loun@nd Start -> All Program -> Keil uVision ¢iogu

2. Gnfulundalnillouns adnd Project -> New Project Wisanal4addalaams

NG Alt+P Wdienuene N

1 » 1 1
3. yamadandumisfialunde uasdsdalindamunnudiooms Waduusanlw

Ea) dl
ARNN Save

4. Wavimaifinlundeduufosuds arldwieha Select Device for Target Wa v

enudanidiaimaerdulumnudon il lilaseoalnsamnadialm u

o v d
fmagld ATSOC51AC2 Faifiusay Atmel
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v 4 A ¥ o A d [
IWHMTLaau Scroll bar AIN1AUDY Atmel uaaann @ lW'E)ﬂ'm"ITLLUﬂlUE]?WN"'I‘

+

w H ﬁllp a A €A L ‘1 ada ¢
PENHT VEIINUUKLINLEDY Scroll bar IN1UDILLDIVNADINTT LUNUABLLDT

ATBIC5EIACZ WasINUAGN OK

_meian il glunda TnalWdremndeaiulng ¢ smndolutindsniu

ﬁlllu. v\ttu‘[ a A d s o A v vsA’A
NN T8 WG ¢ naularadniaanh File -> New D4TURLAWTIREAURUN

dwsulglwmadeulusunss

CynmseriEundlmiiiuvWg ¢ lnundnfi File -> Save as...

:’I 1 o ﬂ. LT = | A v 1
CHetuthnidvmafsiwddnluflurdeGeuionudr seenunsodana ldanmingng

woslLndndiop)
O oam v a y v
amvdiuiuneuzasmadeulisunssmansumafamiidasms

L] i 3 dl » B d‘ [ '
mmyewW IWdlsSemdauau Woviims Build Target Funafiwrieis Output

' v a
Window WLEFINITIENUIDNAWA®DANAN

B = "

il

B oo [Ben T [y H
A AT Tl aoit {Toriad X Fdmrdes 70 - ' ll.*_...l_'.rd
For tlap, présa FL L Gidi Y mj

U 3.2 udmepimhaovasllaun Keil

\ay - a X . da X a v 1 .
“TH‘LNNTJQNG]Wa'lﬂLnﬂ?]u“ﬁﬂ\n'].[ﬂ'ﬂlﬂ'iuﬂWHu‘ﬂuuﬂ?TNQHWENWTN‘E’J“’JU‘HBQ?@“W“%@

1 = 13 W o1 1 nl' =l X : -l ° 3 A
F3E) ‘UNﬂ']‘iL‘UEI%I‘]J‘iLLﬂ‘iNLLﬁ') Lm‘lﬂmwmumwmﬂﬂmnwwmummu%umwmugn@mamw

doammanaluwnz Compiler asvmaamaseusm iz iurasmadoulsunTawintiu uwisehsls

ﬁﬂ'l}l LIEINITNLATIREDL Nanwﬁmu'ﬂaa‘[ﬂmﬂm‘l@'ﬂ@ ﬂm'ﬂ"ﬁmwmmsm a9 Kell GIMIVING’I

Debug #iolt/
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. ) x]

_:j%

“CMET) Ktcp-equivsContent-Type conieht~'text/htm}: charsecsdindove-2T4=
“eMETA cOntune=‘Micrasoft FrontPaye S.0' namesGEREPATOR:"

"< /HEAD 4 FRAMESET boedevs0

riromespacing=D CframeBocdersd colar250,%>"

“SFRAME OoEtenAvigalaL AnCs 'Ravigatob iRl freneBardersan>®

S FFAME nemesmain f1oe'Gops hoal' framefozdepuanest

e FRANESETC FHTHL"

= m thweasmvﬂ
= 33 MINI WeB SERVER
" 18 sranTUP.ASL

, char code BLAEE[] =
"Tlease Wait,..."
Tfcmeta BrEpeequivereryesh! contant=’ STy ad

cher code startl[] =
"Pleasd select the xsnu £o modify Configuration....™;

char code nevigscor[] =

i

71 3.3 wanadeulusunsuddanldom

3.3.2 N199519 Website
5’%mun1ia§1atanﬂ11 HTML #1¢ Notepad
1. \fan Start > Program > Accessories > Notepad
2. s mngwienaraslsuni Notepad
3. Wfionans HTML Fanmeinlai

Fis Edt Format Yew Help

Kkhtmt»

<head>

cl}ﬁ)<5R><B><center><h1>0n - off and Status Report System for Switch via Interne
</heal

<BODY bgColor=#ffffff>

<TABLE height=148 cellPadding=1 width=169 border=0 cellspacing=1 style='border-
<TBODY> <TR>

<br><b><center)<h3>P]ease selact the menu to modify Configuration....</h3></cer
<TD vA'I':gn-top al 1gn-m1ddle width=51 height=1>

<IMG border=0 src="C:/SAT5102.1PG' width="150" height="114">

</FONT> </B></TD><TR>

<TD wAlign=top a'h?n-rn'ndd]e width=310 he'lght =263 colspan=2>

<B><FONT face=Arial color=#00008Q siz2e='2"»SAT5100.NET</font></b>

<BR><FONT face=Arial Helveti ca size=-1»

<BR><A target=' ma'ln href="http: /" /" /tcpip.html’ ><b><font facesArial size=2>)
<BR><A target= main’ href-! ht At fserial himl ' <bscfont face=Arial size=2:
<BR><A target='main' href="htt '/""/""I'lnput htm) ' s<b><font face=Arial size=2»]
<BR><A target='main' href=' htt /" '/""/outgut heml' z<b><fomt face=arial size=2:
<BR><A target='majn’ h eF-'htc g fteen . htm] f»«pr<font face=Arial size=2»Te
<BR><A target='main' href= http /"'/"”/home htm1' »<b><font face=Arial sizeed>Hc
<BR><BR>

<P align=center><FONT color=#21BB58 size=-1>Select from the menu above to modii
</FONT> /P> </FONT> < /FONT» </ TD» </TR> </TBODY> </ TABLE> </BODY> < /htm] >

- = v o
9un 3.4 LAGIMIDEUAdImEM HTML
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: Lﬁﬂnmk} File > save

_avnngwiiehe Save As Bifansumis Save in

\Bangiinuna WA Save as type (i All Files

 is%olwE HTML 7 Filename lovasdaaliuuanadiu htmi o hem whth

. AAN Save

@ity Foider Aanidudumisfulwdasnng W HTML Aldtuinty (fana

W W ~] M

fldydnuel £ aguumihan)

mawameiwdianas HTML § 2 3% e
55 1. musaeiwdianss HTML Toedlorw E Tefifumoudsdl

1. sudlandnd W& udDNINY File > Open

2. AAN Browse

3. BantolWadasmsda adn Open

4. AN OK

5. rTInguadwTTedlWAenms HTML shw Web Browser
37 2. mawsndwdenanlanas Siunaussd

1. sudananiige Wdonen i

2. slmnguaswirasiWalonans HTML s Web Browser ¢iag1l

DD W@ e s @ 20 s 8 S
P \mw!swm\kww'ﬂ w-bl.ﬂumm" vj@ w0 Nk A Sl -
Cogle G~ _Uﬁuaa Qmm ;-s""'* gzmmd ‘Fomd o« B sattingse
On - Off and Status Report System for Switch ©
via Internet
Please select the
menu to modify
Configuration....
SATI100.NET
IcPap
Serlal Pors
input
Quiput
J—- ¥

gﬂﬁ 3.5 Leed IWANET HTML t11 Web Browser
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st Poteom 803 Ly o4 - S B

roshpeseoten bt F]Edee s * setmmionn 4.
[vooé @~ o Bocmoks- "R Bvaitoaed ‘Powc - ¥ Q) sattnae

ouTRUT 1 oFF ]
CUTPUT 3

Charigas wll ke efoct altr ke ugickate,

Uf 3.6 uaAaIINY Output ATANMINIMKIL Web Browser

[ 4 -1
3.3.3 MIFTNTLULADNDU
q o Pl w l! vy q - I.II o o !IJ
suvfendu Mo stuudmiuasasauBramadn omSuuenndiadu mnduuanndindu
:ll (] 5 .y 1 3 L - 1:
Arwannauwsnduszuuewizsasaandn g lfomdunanwiindudiosszy Username was
password naufiasih llFnuguinneien v usnadesyn Wadaya uilsdoya viaaudaya du
-1 | v e . \l F A [ o
o Yatvogiudnuoesmai ihiseynd wiemassnuuuessdWanniiy
3.3.3.1 masianedunadudnsRentu
-'3 .:f [ v 6§ s w - - [ R Y
FusmputaviumIsnanaIndvsunIRansu I@mﬂ'ﬁ@ladiw Username W password
] A& L ] -
wammassufvnumadh lfou lassufumsunmamaiadanlumsingiuvesmiiduma
uasuwsnWasually
3.3.3.2 SunaumadanediNeuamMIiandn
1. fnlsunsn Dreamweaver MX A@niny File > New aznnglassfan New
X . v Y.
Document 2w WaBnufiy General 1dan Dynamic Page > PHP #iganuuaan
1N Create ufingiulwg login php
2. usnaiuasluduma lauadinfieny insert > Form > Form rfimvmedagasmods
‘I fmlogin laeWednianuiin <form> 7 Tag Selector UFnmueUaIBYES
whaa vasnTuli ey Window > Properties Watnnglaazdan Properties

Wrsidaviafuluges Form name
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Log in Form
Login.php

knemame.liusword

Check
Username/Password

Login.php

Re-direct to
Loginfailed.php

Re-direct to
Main Page (ligt.php)

# 3.7 uded Flow chat T895uU&DNBY

B

d . .
91#l 3.8 uFAINITIVUA Properties 4aIraHy

] L
3. wnenmemeldiSuva Taeadinfisn Insert > Table watWirhvuesdasia il
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Rodes:
Tk ik

Border thickness: 1 phiss
ooty 3 f
Col spacing: | 1§

qU# 3.9 udmmaTmunesaslaazian Table

A . oA < | G W \lv s . v
4 HAEUULNIIENYUNDUF N LTILRIRY ALILWIRNI) @N?ﬂ

sut 3.10 usmaSumalva loginphp

’ ]

3.3.4 M3igrmlysunsst Windows Media Encoder

oA v . v 4w . ) ¢ ¢ A 4 v 3 oA "

Raududoeinenad ity Streaming Video [ @urawid B wesslsfvuiiesld
Internet 3¢UNMITS Video 910 Internet tiilniSasfiennanmmeniae Download 101 File
a L/ . - w wad \
il Video Yavumsnaasdssnaninaaiiditsuilarulasianudulylaumansuwws video
wm Internet uwasiuliliiassmgfidwmdimnedaiive muumsfiedefemadumads

Te9 Intemnet Hmsnalnzéwdt fisanandedayalifivszanm 28.8 Kops anwfisnmagzas VCD &

1
o []

o i L% :' a L3 E d' -I ! l’A o
danndeayafi 1150 kbps dariudEmafianhldfessdioads Video Hanmisdndiigeiiagiiu



Yenananfiasinld daumaluladfidunds sueaming Fakutlagtunieasning TV km
4 Internet WWhvidaeing i Internet 16

Video 13165 uaatfiu Format 283 avi w3a mpg # i@ wisndslugluuuges
stteaming I¥adasinsuasderaudsunnuasiuillwnmmmelusunditousndluid
wlflunsumasAtn Microsoft AelUsunss Windows Media Encoder 39if8mavigiai]

3.3.4.1 W3eN Video Flle

TneeSunain Video findmdoliudausainiu Video Aflnnnenlnninenmindiu
mauémtﬂaﬂzmniunmwuuw%mu Internet

3.3.4.2 {WaltaunTs Windows Media Encoder

dl F- I‘.‘i 2 £y J’ L7 "'.'J -,
dafedlUsunmusiudmanenda llsunsadun FeulddiitfuaaunedallsunTuy

b§ ) Lexmark 7600 Series vl
& windows Live Messenger

| 0 Eset R
Tl windows Madia Utilities »
@ Windows Medla Encoder

7u# 3.11 plusmmadialisunsn Windows Media Encoder

1, AP Start >> Program >> Widows Media S¥WuWnUeNd Windows Media
Encoder amwiindniiunuénda Windows Media Encoding
2. uaaIMialUsunsy Windows Media Encoder 9 Wi?18an broadcast a live

event



4

Gmadcad & bve reen fom allached
e o Corapuler scen.

Newe Session Wisard

Davice (plione. .
Salact the devices La-une for ancading awdko and video 1 W smasion. Oy cammenily
ristalled davices s Beted.

What devicet da you wanl 1o wse?

izl video davics R

boeeptaa k. bk d e

[ At

T . .
@ Click Gonfigure Lo’ set prapeilies for thel seiscled dévion.

d a  w
7UH 3.13 wERIMILHANNRDI

3. danndasiquiltlumsdaluswnn



Heww Sessivn Wizanl

Bigadcast Wathod
'You can bioade st content by pushing it to & Windowa Madia saver o by alowing
players o 'Windows Media eervers Lo pul deectly from the sncoder.

_ " How do you wani to ioadcast your sncoded content?

. ﬂ;" O Puthio a'Windows Miecia server (the connection i intiated by the encodei}

(Z)Pull from the ancoder (the sorver o plaper inliales the connection|

T S
@ For infemation about eatling Up & push distribition sessian, e Help

oo ) e ] (o ]

‘gﬂﬁ 3.14 LE@AINIASN Pull from the encoder

4. \8an Pull from the encoder

Pow Session Wirad

| Bioadoast Connection
Selact the pait through which plapait md\bfnduwHuiamcmau:mm
slinam

What port do pou want b0 wre?

- it |

UAL for Intemei connections: E’F&"&?ﬁszwm.mm/ “]I

-UAL i LAN coreections.  [hipe /HacZE/ 1

@ “ou can copy the LRL and mavide i to uzess o they can sccess the stam,

51 3.15 wdaanITvMe Port

5. AmueLaY Port enudwasmuinathatmuady 2007 vioanlsayllusunsugan

WA
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Encudding Options

Sielect sncoding sattings fof your conteni. You eelections detemine setlings such a3
bil tale, hamo tate, and bullen size.

How do you wani to encode yous sudio and video?

Video

huds (Mo bises a0 CBR) v

Gse TowmRas  FawRes  Oupasm A
i (] 45Kbps
! [ 37 Kbes -
L[] 24 K " M

CTip

You can adusi seitings on the Seasion Properties pansl after you complele
the wizaid.

[LcBack J{_Netz § | r‘.-:mircm.l_

27 3.16 ussmAendanenuFiasofi Kbps

A w o e 1 ﬂty A L] N vy [T v EY e
B. IRIMDANTIAIINLTT LUEUIN VLRBNUDET) §11°) ‘lfmauu,mﬂaumﬂ‘:ﬂwwa%nu

NEaT

Mew Session Wisard

Muchive Fils
You can creals an &chive fle of \ne broadosst.

e :
7} Tostaror ciop the ichive whie encoding. umk the archive coniiol ot .
& Conmime 5

[ <k L N;n:»r | [ r?.'m- ] [ Cancel ]

(3 v

48 3.17 wamenaiiutayafidinammiuin

7. windipamaiunmiaonainiealiglunemss (30 video iuld) uamnlaidiaants
Fufilidaadontiivswinilailude
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MINASDILLATNRINTNARDY

1 °
4.1 Na1IW
[ 5
Iudmeasumilaznanfomvmasusenanimaaasvasganasasszuuiile - fa uay
a6 L) { a (-1 (] G ]
esmsmwsaIndimaiatisdunaduin bineufiuludmsanseseugu msmuguem
- 1 -_ 1] J
Swaaddin msusaawaraammimBuaetifin warludrasemlseyndehan Falfltaunay
MdvnaRIUAY I I9hE)
v A * a K
nnudwinsuemsitandalasmsntassiuude - Oa warneavwdomeaiofiom
= + = ‘i = . -~ -1 . ] =t
whohudwaaiule SimsGunliusansonssilafedl snefasnasfumadinawmnGanfou
i = d = i ] | N ¥ -
laushmltsunsuimaafilaze:d HUB fugunsallunidandadnfussudunaiin wae
A 1 e - [ ) a o 4 Y [ Y] A’ A ¥
Fandadhiuneniaumaidniniasflilunismugy fegneasnaniaimeidiiasiveta
SAT5102NET uay WEB CAMERA iTandasylfisnaimisndemsniuguniaia - a
wiaelthwih wssgrmmalmluanneiiogifimalFomls

BOARD
SATS102.NET

!

COMPUTER INTERNET HUB ——#! COMPUTER

T

WEB
CAMERA

U 41 wesnsiandn rmeasteuu e

4.2 Mamuaugnsalshussuumadin

4.2.1 MIMWRAAILELNIS LSS 142 Ethernet
31 2 du Ao ICMP, ARP, IP way MAC



Jumarimue P uat MAC ADDRESS siussmnvhidadadenlumstusunsnliiu cpu
sressoutleléfdaiaimautleludunas SOURCE CODE rauvhmaliunsasuudh CPU
uoxacl¥ 1P Arueiimaowsiernssy LAN

Snwnizaad P asldrufu 8 BYTE [FF-FF-FF-FF] dunnaafwargmdussle
(255.255.255.255] 1819131 Mue 1P 192168.1.2 13Atedas PC uda ifimmuefivade
neulrraiaedliiha P 192168.1.3 Aldudlidiy P vaneiosiu

§nweeay MAC ADDRESS asfiénufiu 16 BYTE [FF-FF-FF-FF-FF-FF] azflusuany
aseriourfusadnarlimiuludiuzaeiot gy fvua MAC: 00-00-43-4E-4F-45 #1389
Sufaedodlaldent

ICMP 38 PING 1flu PACKET 989 IP ADDRESS ¢hvils fidulwgiamianidadiehae
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ot - dediagyn dudu
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arvvasautiull

mIdemy LAN 104@ias PC fuuafanaalniamethaalaelsisu HUB wia SWITCH
Tldsneunle’ uasfhrim HUB via SWITCH Wlmewing
4.2.2 Suyauaziondwavasuefanaulnained

Suna 4 Wadn (OPTO INPUTS) uadl LED usnsamucvasdunmumvaianaulmainad
Yae3n 0 fia OPTO ¥ham (ACTIVE LOW)

tawﬂvgm 4 wo3a (RELAY OUTPUTS) hatdl LED LLamamuwaq‘ﬁuwmuuua%m
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424 madansevsslulazrealnsamesivladiuinedila
1. DATA INPUT/QUTPUT 8 iia
2. ADDRESS & {io
3. LED uanssionusuiiwdueedicio 3 ang (LINK, TXD, RXD)
4. mydensioku LAN wly FULL DUPLEX 10 BASE-T
4.2.5 MItvuammMeBuinadiin
1. IP ADDRESS Wl 1P: 192.168.1.2
2. MAC ADDRESS W& MAC: 255.255.255.0
3. fiwaue PORT it PORT: 23
4. madamuandvmnniedes PC Tlwiumnamads
5. NT3EMeNBUNA A PC mamne 10 Sufl
4.2.6 matwualuslanss DATA PROTOCOL
i hTudarimualunsdesadiomnwinnasianeifuueialilasnealnsanad 14
lusleeaa TCP ETHERNET PROTOCOL
W Rp Wumemssonueeashlsuns:
W RuooProoc dumsnsLrasnes mameimdinuvianimamnedwarien R uos
P s1Uandn U uRnRaNinIng
4.2.7 ﬁ'lé"ﬂunﬁmuqunﬁﬁwmﬂm RELAY OUTPUTS
Al =Relay 1 ON, Bl = Relay 1 OFF
A2 = Relay 2 ON, B2 = Relay 2 OFF
Al = Relay 3 ON, B3 = Relay 3 OFF
A4 = Relay 4 ON, B4 = Relay 4 OFF

° | a § G
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mavaueestsda - Tauarnanuamussiadruszuudugadiinagainoing
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4.3.1 MIAIUANUETA SAT5102.NET

1. vnisdaifangunialfoguil 1 e IueSasATs102 fidn P vy

a

192.168.1.2/24 INVMYIMSIEd RN nnatiie [P:192.168.1.20/24 1NvuyYms
[1

sadanmuuy et wieSaiureNimaes

SAT5102
IP: 192.168.1.2

RJ4b

SATS5102

COMPUTER

RJ45

CMPUTER
IP: 192.168.1.20
Sub: 255.265.206.0

31l 4.2 mafexdeguUnanilumveasinmunauada SAT5102
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Fie and Portar Shasing For Momsoft Hatwoss | |
Q65 Pachel Schuduer i Deled gulewey :
™ Kiwist Protaod (TCP/iF) i P
Pegre e LE{ %) Lz the lalgmang DHS server acddmeaes; H
T S— Pratered DNS sarvar
© Traramismie Cortrd Fretscol eduma Protoesi. The oot | . ‘ -
wids 2vua rwnwork orotoosl Bl Drovides communicationf | P2t OHE wser ; |
acoas dvarse rlerconvacted retnotks 3 T
A R £
i [¥] Show con In notficaton ares when cornectec! i :
H EMMWMWMMNMM e b s L i g e
[ owen )

11 4.3 midieen 1P Wunesiess



51

2. vnmavesaulaelginds ping

71 4.4 Ham3dRd ping MavedaunBansouaSauavaasRamain sy LAN

4.3.2 MIARRRNUNARS Web Camera

~ D o s W N

YmafingandesmagUil 4.1

. ymitamadedelunts Windows Media Encoder

. nedaumTaMeaslsunN windows media encoder

_ annmidaeias

. 981 Video Iauidensfiovasniasignéias
 daehmadondelan@an PORT #rivayufididentien 2500

Yo A o i
. 9" Compression 1 141 Kbps ua 58 Kbps Famsnvan e 141 Kbps muw

e Miser s LAN wat 68 Kbps mansiunsiaasiariu Modem

11]'?5 4.5 NTI8RMTaINIUNTN Windows Media Encoder
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1. @alisunsy Internet Explorer 1d URL: hitp://localhost/Project. php
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4.3.4 manasey Wseihulvaunay we_tep

vanaInmsianTTINA I File Manager Aliszennanisinlumsiamalauds Wsas
Sonimlumsadiialaiuntiny 3 I udRdeiinivildmsmnmediniriuifemsiens
Idrmaluzinga Ws_ftp thuaandy

M3 EnulTunTn Ws_frp Lﬁaia’ﬂmﬂwéﬁaada'swinméawadmuﬁu Hosting Siinam
s adteit

1, fiadolaunma Ws_ttp Wideusan wdidekisunaaiuen
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2, umnirasdniaueany! Connect 3INUUARNY Create Site

| Waicome

. Competiry st Carecton Waard wil
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4. ldfedlFim upzniasim madhg fip (Dasdulenfivimisnindmihfiquassuy)
»
NvuNA Next
5. fina1lugad Server Address o Host Address \eurimuasnifiu unix kmitlac.th

»
PRNUUNA Next

 Server Address

Evary FTF server has a Lnique acdness known as the Server
Address or Host Address.

| For Exampie:
» mywehpages concast net
= ftp, hometown, adl, com

[ Enter i server addrees provided oy your Imtermet Sarvice Provider
[ (ISP) or your FTF server administrator.

L N o I

gﬂﬁ 4.18 m‘ﬂﬁ%a‘lu Server Address

6. fiaanugas Connection Wizard ¥ tdzad Suavaisrhugamim

[ User Name and Password
FTP sarvers roquine & usac name and pasowcrd,

Enter the user name and passwart! provided by your Intemet Servica
Pravidar (JSP) or the FTP sarver adminish alor.

NOTE: Entering a password balow |5 not required. If you choose i
ertter a passwird, WS_FTP will safely sava that password for fulre
connactions 0 this site.

i
[-srssn

Pt

gl.h"'l 4.19 M7 User Name La¥ Password
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7. Waunsashaqrneidanyimuali atfias Checkbox Connect to this

, | TS dl - A‘l‘ 1 .
site MOPNWMENA Finish [eitidd@any Hosting

| Finish

If the foliewing Information = correct, tlick Fnish b oeate the site.

t0 this slte option.

s Connection name: sB035517
w Gerver addrees; unix kmiti.&c. th
« User name: 8035517

M w.‘ puEkrmy

REMEMBER: You can open this she from now on using the
Contwisct bution on the main application oobar.

L

gﬂ'ﬁ' 4.20 uaew User Name Wav Password Lﬁamﬂi\aaummgnéim

L a_da .. o I‘: 1 ] v a_A A o ]
8. YUV AGANY Finish IWOILMITNALFETURIAGNVILATAINMNEGNEIAM Connect NIY

woAamTTandein ne 1y edndenaneuiiis hsunsuiFansadudefiauusid
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T
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o 3 ¢
AT Al ﬂunmaaqﬂnsmaa’mmﬂmquumﬁm - TalasMENUEN UL 19T

Fogqunanl uaridun dman
HUTIN
IC1 TBICS1AC2 14
ic2 MAX-232 189
Ic3 LM2575 197
Ic4 24LCXXX 160
gunsalmafiedianiy
Q1-04 9013 4 9
D1-D4 1N4002 44
D5-D8 LED 4 ¢n
D9-D12 1N4148 4 dh
D13-D16 LED 4 ¥
ZD1-ZD4 5.1V 141
OP1-OP4 PC817 16l
PW1 LED 140
DK1 1N4001 14h
ﬁ'uﬁumzq
C1 10 uF/35v 1¢n
C2.04 0.1 uF/16v 3 6
C5 0.1 uF/16v 140
C 330 uF/16v 491
C11-C14 0.1 uF/16v 140
CR1 10 uF /16v 12
CX1.Cx2 22 uF /16v 29
AIRTNAUN I
R1-R24 10K 14W % 24 ¢
R25-R28 470 £ 1 % 440
R29-R32 1 k) W % 4
R33-R36 10K 14W % 46
R37-R40 470 £ 1\4W % 4
RP 470 £ 1\W % 14
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a9l A2 TEMIgUNINTRs Ethernet Module

dogunscf Twaniun i
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IC1 RTL8019AS 16h

gunsnimafiedioia
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daiulezy

C1-C10 0.1uF/16v 10 ¥
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Ji REALTEK

RTL8019AS

Realtek Full-Duplex Ethernet

Controller with Plug and Play Function
(RealPNP)

SPECIFICATION

REALTEK SEMICONDUCTOR CORP.

HEAD OFFICE
NO. 2, INDUSTRY E. RD. IX, SCIENCE-BASED
INDUSTRIAL PARK, HSINCHU 300, TAIWAN, R O.C.
TEL: 886-3-5780211 FAX: 886-3-5776047
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o REALTEK

1. FEATURES

O 0O OO0 0O OO 00O

o ©C 0 O O O

©C OO0 0O O O

100-pin PQFP

RTL8019 software compatible

Supports PnP auto detect mode (RTL8019AS only)

Compliant to Ethernet [T and IEEE802.3 10Base5, 10Base2, 10BaseT
Software compatible with NE2000 on both 8 and 16-bit slots
Supports both jumper and jumperless modes

Supports Microsoft‘s Plug and Play cenfiguration for jumperless mode
Supports Full-Duplex Ethernet function to double channel bandwidth
Supports three level power down modes:

- Sleep

- Power down with internal clock running

- Power down with internal clock halted

Built-in data prefetch function to improve performance

Supports UTP, AUI & BNC auto-detect (RTL8019AS only)
Supports auto polarity correction for 10BaseT

Support 8 IRQ lines

Supports 16 'O base address options

— and extra /O address fully decode mode (RTL8019AS only)

Supports 16K, 32K, 64K and 16K-page mode access to BROM (up to 256 pages with 16K
bytes/page)

Supports BROM disable command to release memory after remote boot

Supports flash memory read/write (RTL8019AS only)

16k byte SRAM built in (RTL80I9AS only)

Use 3346 (64*16-bit EEPROM) to store resource configurations and 1D parameters

Capable of programming blank 9346 on board for manufacturing convenience

Support 4 diagnostic LED pins with programmable outputs
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34 REALTEK

2, General Description

The RTL8D19AS is a highly integrated Ethernet Controller which offers a simple solution to
implement a Plug and Play NE2000 compatible adapter with full-duplex and power down features.
With the three ievel power down control features, the RTL8019AS is made to be an ideal choice
of the network device for a GREEN PC system. The full-dupiex function enables simultaneously
transmission and reception on the twisted-pair link to a full-duplex Ethernet switching hub. This
feature not only increases the channel bandwidth from 10 to 20 Mbps but also avoids the
performance degrading problem due to the channel contention characteristics of the Ethernet
CSMAJ/CD protocol. The Microsoft's Plug and Play function can relieve the users from pains of
taking care the adapter's resource configurations such as IRQ, /O, and memory address, etc.
However, for spectal applications not to be used as a Plug and Play compatible device, the
RTLEO19AS also supports the jumper and proprietary jumperless options.

To offer a fully pfug and play solution, the RTL8019AS provides the auto-detect capability
between the integrated |0BaseT transceiver, BNC and AUI interface. Besides, the 10BaseT
transceiver can automatically correct the polarity error on its receiving pair. Furthermore, 8 IRQ
lines and 16 VO base address options are provided for grand resource configuration flexibility.

The RTL801SAS supports 16k, 32k & 64k byte BROM and fiash memory interface. It also offers
the page mode function which can support up to 4M-byte BROM within only 16k-byte system
memory space. Besides, the BROM disable command is provided to release the BROM memory
space for other system usage (e.g. EMM386, etc.) after the BROM program 1s toaded.

The RTLBOI9AS is built in with 16K-byte SRAM in a single chip. It is designed not only to
provide more friendly functions but also to save the effort of SRAM sourcing and inventory.
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4 REALTEK

3. PIN CONFIGURATION

66 BAZl [PND| &5 _JP

67 BA20[BSH} 64 AUl
68 Bals (BSI] £3 LED2 [LED_TX)
 BAIS(BS2) 62 LEDI{LED_RX| |LED_CRS|
™ VDD 61 LED® |LED_COL] [LED, LINK}
71 BA17[BSH ¢ LEDEBNC

72 BAL6 {BSH4] 53 TPIN+

73 BAIS 58 TFIN-

T4 BAI |PLAO] 57 VDD

15 BCSB 56_ RN+

7% EECS 33 RX-

77 BD7[PLLI[EEDO] 54_Ch+

78 BD6 [IRQSO][EED]] 53 CD-

79 BD3 [IRQSI][EESK] ) ——— 51 _GND

B0 BD4[IRQSY 51 X2

81_BD3 {1OSU| I 1D D
82 BD2[108] I W 5. €
£3 GND 48 TX-
$4_BDI1JI0SY) l 42 vpD
8 _BDO 10S3) | 46 TPOUT-
86_GND | 45 TPOUT+
87_5D18 | i

RY_ VDD | 2 sob
% Spld | 41 Ssbs
o | RTL8019AS Y —
9 spil | 3¢ S L
93 SDle .38 sp2
[T .37 800
95 5D l s Sspo
% 1OCS16B [SLOTI6] L 3 JOCHRDY
97_INT? IRQISI .M AEN
98 INTé [IRQ12| | 33 RSIDRY
% _INTS [IRO11] | 32 SMEMWE
100_INT4 [IRQ10] |31 SMEMRE
1 INT3 |1RQS) L3 IOWE

I INTZIIRGH) 29 IORB

3 INTI [TRQ3] 28 GND
QINTOJRQ28 | b2 SaAlY

§ 8AD - I 7. 11

6 VDD 15 SALTY

7 SAl 24 SALS

& Sa2 23 SAlS

¢ A1 1 SAld

1 5ad il_SAi

11 SAS ¥ SAR

12 SA% 19 _SAll

13 SA7 18 SAl0

14 GND 17_VDD

15 SAS 16_SA%
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4. PIN DESCRIPTIONS
4.1, Power Pins

~ No. Name Type Description
6, 17,47, 57,70, VDD P +5V DC power

29
14,28, 44, 52, GND P Ground

83,86
4.2. ISA Bus Interface Pins

Na, Name Type Descriptions

34 AEN I Address Enable. This ISA signal must be low for a valid 1/0

command.

97-100, 14 INT7-0 0 Interrupt request lines which are mmapped to IRQi 5, IRQ12,
IRQLL, IRQI0, IRQS. IRQ4, IRQ3, IRQ2/9 respectively, Only
one line is selected to reflect the interrupt requests at one time.
All other lines are tri-stated. The RTLBOI2AS also uses these
pins as inputs to monitor the actual state of the corresponding
interrupt lines on ISA bus. The result is recorded in the INTR
register, which may be used by sofiware to detect interrupt
conflict,

35 I0CHRDY 0 This 1SA signal is driven low to insert wait cycles to current
host read/write command,

9% I0CSi6B 0 Upon power-on reset, this pin acts as an input named SLOT16

[SLOT16] to detect whether a 16-bit or 8-bit slot is in use. To do this, it is

connected to a pull-dewn resistor (about 27KW} externally. At
the falling edge of RSTDRYV, the RTL80I9AS senses this pin's
state. IFit {s sensed high, the adapter is thought 10 be placed on
a 1 6-bit slot where this pin is connected to the host's IOC516B
pin, which is typically pulled up by a 300W resistor on the
mother board. 1 it is sensed tow, the adapter is thought to be
placed on an 8-bit slot where this pin is merely pulled low by
the 27KW resistor. After having latched the input state, this
pin is switched as the [QCS16B signal which is an open-drain
output and is driven low during a 16-bit host data transfer. It is
decoded from AEN and SA9-0.

29 IORB I Host I/0 read command.

30 1I0WB [ Hast 170 write command.

3 RSTDRYV I High active hardware reset signal from the [SA bus. Pulses
with high level less than 800ns are ignored.

27-18, 16- SA19-0 1 Host address bus. SAIC is added to implement the fully

[5,13-7,5 decode of PnP ports, address 27%h and A79h. In RTL38019,
8A10 is not decoded. In RTLBO19AS, SA10 should be 0 for a
valid access to PnP pors.

§7-88, 90- SD15-0 10 Host data bus.

95, 43-36
k)| SMEMRR | Haost memory read command,
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32 SMEMWB 1 Host memory write command. This pin is added to decode the
write command of a flash memory.

4.3, Memory Interface Pins {including BROM, EEPROM)
o Neo ~ Name | T?P.e - De’ic;“i‘ﬁ"" »

75 BCSB 0 BROM chip sclect. Active low signal, asserted when
BROM is read. RTLBOI%AS drives this pin low when
SA19-14 matches the selected BROM memory base
address and either of the 2 conditions below meets:
(1) SMEMRB is low

(2) SMEMWB is low and RTLB019AS's flash memory
write function is enabled.

76 EECS o 9346 chip select. Active high signal, asserted when 9346
is read/write.
66-69,71-74 BA21-14 0 BROM address, *
77-82, 84-85 BD7-0 110 BROM data bus.
""" po | EEskl | 0 |wessedalsmcock
[78] [EED!] 0 9346 serial data input
(7N {(EEDO] 1 9344 serial data output

The following pins are defined for jumper options. Their
states are latched at the falling edge of RSTDRYV, then
they are changed to serve as the SRAM bus. Each of them
is internally pulled down by a 100K W resistor, Therefore,
the igput will be low when left open and high when
pulled up by a 10K resistor externally.

........................................

[66] [PNP] [ When it is high in jumperless mode (i.e. JP=low), the
RTLBOI9AS is forced into Plug and Play mode
regardless of the contents of 9346,

The following pins are don't care in jumperless mode

(JP=low).
[72-71, 69-67] [B54-0] ! Select BROM size and base address.
[85-84, 82-81] [1083-0] I Select 11O base address.
[77, 74] [PL1-0] | Select network medium type.
[BO-78] [TRQS2-0] | Select one interrupt line among INT7-0.
65 JP ! When high, this pin selects jumper mode. When low, it
selects jumperless modes (including RT jumperless and
Plug and Play),

% After RTL8CG19AS latches all jumper status upon power on reset, these pins efways* reflect the value of BRAGE register
directly in BROM page mode. In normal mode, BA16-21 are not used and BA14-15 act as:

" BROM $ize " BAM - BAIS
16K high high
32K SAl4 high
64K SAl4 SAlS

*Note: RTLEOI9AS doesn't drive BA14-21 until the SMEMRB goes from high to fow.
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4.4. Medium Interface Pins

_No.

Name

Type

Description

64

AUl

This input is used to detect the usage of an external MAU on
the AUl interface. The input should be driven low for
embedded BNC and high for external MAU, When the input
is high, RTL8O19AS sets the AU bit (bit5) in CONFIGO and
drives LEDBNC low to disable the BNC. If this pin is not
used, it should be connected to GND such that RTL3019AS
acts like RTL8O19, Please refer to section 5.1.2.2, CONFIGO
for more defails.

54,53

CD+.CD-

This AUI collision input pair carries the differential collision
input signal from the MAU.

56,35

RX+RX-

This AUI receive input pair carries the differential receive
input signal from the MAU.

49,48

TX+TX-

This AUl transmit output pair contains differential line
drivers which send Manchester encoded data w the MAU.
These outputs are source followers and require 270 ohm pull-
down resistors to GND.

59,58

TPIN+,
TPIN-

This TP input pair receives the [0 Mbits/s differential
Manchester encoded data from the twisted-pair wire,

4546

TPOUT+,
TPOUT-

This pair carries the differential TP transmit output. The
autput Manchester encoded signals have been pre-distoried
to prevent overcharge on the twisted-pair media and thus
reduce jitter,

50

X1

20Mhz crystal or external oscillator input.

5t

X2

Crystal feedback output. This output is used in crystai
connection only. It must be lef open when X1 is driven with
an external oscillator.

4.5. LED Output Pins

No.

Name

Type

Description

60

LEDBNC

This pin goes high when RTLB012AS's medium type is set to
10Base2 mode or auto-detect mode with link test failure.
Otherwise, this pin is low. This pin can be used to contro] the
power of the DC convertor for CX MAU and connected to
an LED to indicate the used medium type.

61

LEDQ

When LEDSO bit {in CONFIGY register of RTL3019A%
Page3) is 0, this pin acts as LED_COL. When LEDS0=1, it
acts as LED_LINK.

62,63

LED!LED2

When LEDSI bit (in CONFIG3 register of RTL80I9AS
Page3) is 0, these 2 pins act as LED_RX & LED_TX
respectively. When LEDS[=I, these pins act as LED_CRS
& MCSB. Please refer to scction 6.5 for details of the
lightening behavior of all LEDs.
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5. Register Descriptions

The registers in RTL8019AS can be roughly divided into two groups by their address and
functions -- one for NE2000, the other for Plug and Play (PnP).

5.1. Group 1: NE200( Registers
This group includes 4 pages of registers which are selected by bit PSQ & PS1 in the CR register.
Each page contains 16 registers. Besides those registers compatible with NE2000, the RTL8019AS

defines some registers for software configuration and feature enhancement.

5.1.1. Register Table

No (Hex) _ Paggﬂ' Pagel Page2 _Paged
— I’ W] 1R/IW] IR] R 1w
00 CR CR CR CR CR CR

01 CLDAO PSTART PAR0 PSTART 9346CR 9346CR
02 CLDAl PSTOP PARI PSTOP BPAGE BPAGE
03 BNRY BNRY PAR2 - CONFIGO -
04 TSR TPSR PAR3 TPSR CONFIG]1 |CONFIGI
05 NCR TBCRO PAR4 - CONFIG2 __|CONFIG2
06 FIFO TBCR! PARS - CONFIG3 _ |CONFIG3
07 ISR ISR CURR - - TEST

08 CRDAD RSARD MARO - CSNSAV -
09 CRDAL RSARI MARI - - HLTCLK
0A 30191D0 RBCRO MAR2 - - -
0B 8019ID1 RBCRI MAR3 - INTR -
0C RSR RCR MAR4 RCR - FMWP
0D CNTRO TCR MARS TCR CONFIG4 -
OE CNTRI DCR MAR® DCR - -
OF CNTR2 IMR MAR? IMR - -
10-17 Remote DMA Port

18-1F Reset Port

Notes: "-" denotes reserved. Registers with names typed in bold italic format are RTL8019AS

defined registers and are not supported in a standard NE2000 adapter.




83

w R E A LT E K SPECIFICATION
((5 ;\\ RTL8019AS
Page 0 (PS1=0, PS0=0)
No. | Name | Type| Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit0
00H | CR R/W | PSI PSO RD2 RDI RDO TXP STA STP
0lH | CLDAD R AT AS AS Ad A3 A2 Al AQ
PSTART w AlS Al4d Al3 Al2 All AlD A9 AB
02H | CLDAI R AlS Ald All Al2 Alt AlQ A9 AR
PSTCOP w AlS Ald Al3 Al2 All AlD AY AR
03H | BNRY R/W | AlS Ald Al3 Al2 All Al A9 AS
MH | TSR R OWC CDH 0 CRS ABT COL - PTX
TPSR. W AlS Ald Al3 Al2 All All) A9 Al
O5H { NCR 24 Q Q 1] §) NC3 NC2 NCH NEO
TBCRD \d TBC? TBC6 TBCS TBC4 TBC3 TBC2 TBCt TBCO
06H | FIFOQ R D7 D6 DS D4 D3 D2 Di DA
TBCR! W TBCi5 | TBRCI4 |TBCI13 |TBCL2 | TBCI1 | TBCI10 | TBC9Y TBCS
07H | ISR R/W | RST RDC CNT OVW TXE RXE PTX PRX
08H } CRDAD R A7 Ab A5 A4 Al A2 Al AD
RSARD W A7 Ab AS Ad Al A2 Al Al
09H | CRDAL R AlS Ald Al3 Al2 All AlD A9 AR
RSARI W AlS Al4 Al3 Al2 All AlD A9 AR
0AH | 8019IDO R 0 | 0 1 0 0 0 0
RBCRO W RBC7 RBC6 RBCS RBC4 RBC3 RBC2 RBCI RBCO
0BH | g019IDi R 0 [ 1 i 0 0 0 0
RBCRI W RBC15 | RBCI4 [RBCI3 |RBCI12 |RBCt1 |RBCIO | RBCY RBCR
OCH | RSR R DFR DIS PHY MPA 0 FAE CRC PRX
RCR W - - MON PRO AM AB AR SEP
0DH | CNTRO R CNT? CNTé6 CNT3 CNT4 CNT3 CNT2 CNTI CNTO
TCR W - - - OFST ATD LB1 LBO CRC
0EH | CNTRI R CNT? CNT6 {NTS CNT4 CNT3 CNT2 CNTI1 CNTO
DCR W - FT1 FTO ARM LS LAS BOS WTS
OFH | CNTR2 R CNT? CNT6 CNT35 CNT4 CNT3 CNT2 CNT1 CNTO
IMR. W - RDCE CNTE OVWE | TXEE RXEE PTXE PRXE
Page 1 (PSI=0, PS0=I)
No, | Name | Type | Bit7 | Bit6 | Bies | Bied | Bitd | Bit2 | Bit1 | Bitf |
00H | CR R/W PS1 PSO RD2 RDI1 RDO TXP STA STP
0IH | PARO R/W DA7? DA6 DAS DAd4 DA3 DA2 DAl DAO
02H | PARI RW DAILS DAI4 DAL3 DA12 DALl DAIO DA9 DAS
03H | PAR2 RW DA2] DA22 DA2] DA20 DALY DAIS DAl7 DALG
04H | PAR3 R/W DA3I DA30 DA29 DA28 DA27 DA26 DA25 DA24
05H | PAR4 W DA3Y DAIR DA3T DA3S DA3S DA34 DA3} DA32
06H | PARS R/W DA47 DA46 DA4S DA44 DA43 DA42 DA41 DA40
07H | CURR R/W AlS Ald All Al2 All AlD A9 A8
08H | MARO R/W FB? FBb6 FB5 FB4 FB3 FB2 FBI FBO
(94 | MARI R/W FB15 FBI4 FB13 FB]12 FBt1 FBIO FB9 FB3
0AH | MAR2 R/wW FB23 FR22 FB21 FB20 FB19 FBI8 FB17 FBlé6
0OBH | MAR3 R/W FB31 FB30 FB29 FB28 FB27 FB26 FB25 FB24
OCH | MAR4 RW FR30 FB38 FB37 FBi6 FR3S FB34 FB33 FB32
ODH | MARS R/W FB47 FB46 FB45 FB44 FB43 FB42 FB41 FB40
0EH | MAR6 R'W FBAS FB54 FB53 FB52 FB5I FBs0 FB49 FB48
OFH | MAR7Y R/W FB63 FB62 FBé6I FB&0 FB59 FBS8 FB57 FBS6&
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Page 2(PS1=1, PS0=0)

No. | Name | Type | Bit7 | Bit6 | Bits | Biteda | Bie3 | Bitz | Biel | Bito

00H | CR R'W | PSI P8O RD2 RD] RDO | TXP STA STP

01H | PSTART R | AlS Al4 Al3 Al2 All Al0 A9 AR

02H | PSTOP R | Al Al4 Al3 Al2 All AlD A9 A8

03H | -

04H | TPSR R | Als Ald Al3 Al2 All AlO A9 A8

0SH [ -

|

0BH

OCH { RCR R |- - MON | PRO | AM AB AR SEP

0DH | TCR R |- - - OFST | ATD | LBI LBO CRC

OEH | DCR R |- FT! FT( ARM | LS LAS BOS | WTS

OFH | IMR R |- RDCE | CNTE | OVWE | TXEE | RXEE | PTXE | PRXE

Page 3(PS1=1, PS0=1)

No..| Name | Type| Bit7 | Bit6 ! Bits | Bitd | Bit3 | Bit2 | Bitt Bit0

00H |CR R/W | PSI PS0 RD2 RDI RDO TXP STA STP

0IH | 9346CR R |EEMI |EEMO | - - EECS |[EESK [EEDI |[EEDO
w {EEM!I JEEMC | - - EECS |EESK |EEDI |-

2H | BPAGE ww | Bp? BP6 BPS5 BP4 BP3 BP2 BPI BP0

03H | CONFIGO R | VerID! | VertDO | AUT pypJP 1P BNC (¢ 0

04H | CONFIGI R [IRQEN [IRQS2 [IRQSI [IRQs0 J1os3 [10s2  [10s1  [10s0
w* [IRQEN |- - - - - - -

05H | CONFiIG2 R [rLi PLD BSELB | B84 BS3 BS2 BS1 BSh
w* | pLI PLO BSELB | - . - . -

06H | CONFIG) R | PNB FUDUP | LEDS1 | LEDSG | - SLEEP | PWRDN| ACTIVEB
we |- - - - - SLEEP | PWRDN] -

O07H | TEST R/W | Reserved, Do not write

08H [ CSNSAV R |[CSN7 [CsNe [CSNs |CSN4 [CSN3 JCSN2 | CSNI [ CNSO

09H | HLTCLK w [HLT? |HLTe [HLTS [HLT4 [HLT3 |HLTZ [HLTI [HLTO

0AH | - - Reserved

0BH | INTR R [INT7 [INT6 [INTS [INT4 [INT3 [INT2 [INTL [INTO

OCH | FMwP W | Flash Memory Write Protect

0DH | CONFIG4 R |- l. [ - [ - | - | - [ - | 10MS

QEH | - - Reserved

o

Note: The registers marked with type="W™*' can be written only if bits EEM 1=EEMO0=1.

5.1.2, Register Functions

5.1.2.1. NE2000 Compatible Registers
CR: Command Register (00H; Type=R/W)

This register is used to select register pages, enable or disable remote DMA operation and

1ssue commands.
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Bit Symbol Description
7,6 PS1, PSO
PS1 PSO_ | Register Page _Remark
0 4] NE2000 compatible
0 1 l NE2000 compatible
1 0 2 NE2000 compatible
1 1 3 RTLBO19AS
Configuration
53 RD2-0
RD2 RD1 RDO. Function
0 0 0 Not allowed
0 D ! Remote Read
0 1 0 Remote Write
0 1 1 Send Packet
l b > Abort/Complete remote DMA
2 TXP This bit must be set to transmit a packet. It is intemally reset either after the transmission
is completed or aborted. Writing a 0 has no effect.
1 STA The STA bit controls nothing. It only reflects the value written to this bit. POWER
UP=0.
0 STP This bit is the STOP command. When it is set, no packets will be received or
transmitted, POWER UP=1,
_STA STP | - “Function '
I 0 Start Command
0 1 Stop Command

ISR: Interrupt Status Register (07H; Type=R/W in Page0)
This register reflects the NIC status. The host reads it to determine the cause of an interrup
Individual bits are cleared by writing a "1" into the corresponding bit. It must be cleare

after power up.
Bit Symbol Description

7 RST This bit 15 set when NIC enters reset state and is cleared when s start command is issued
to the CR. 1t is also set when receive buffer overflows and is cleared when one or more
packets have been vead from the buffer.

6 RDC Set when remote DMA operation has been completed.

5 CNT Set when MSB of one or more of the network tally counters has been set,

4 ovw This bit is set when the receive buffer has been exhausted.

3 TXE Transmit error bit is set when a packet transmission is aborted due to excessive
collisions.

2 RXE This bit is set when a packet received with one or more of the following errors:
- CRC crror
- Frame alignment error
-Missed packet

1 PTX This bit indicates packet transmitted with no errors.

0 PRX This bit indicates packet receijved with no errors.
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IMR: Interrupt Mask Register (OFH; Type=W in Page0, Type=R in Page2)
All bits correspond to the bits in the ISR register. POWER UP=all 0s. Setting individual
bits will enable the corresponding interrupts,

DCR: Data Configuration Register (OEH; Type=W in Page0, Type=R in Page2)
Bit Symho| Description '
7 - Always 1
6,5 FTi, FTO | FIFO threshold select bir | and 0.
4 ARM Auto-initialize Remote
0: Send Packet Command not executed.
1: Send Packet Command executed,
3 L3 Loopback Select
0: Loopback mode selected. Bits | and 2 of the TCR must also be
programmed for Loopback operation.
1: Normal Operation
2 LAS This bit must be set to zero. NIC only supports dual 16-bit DMA mode.
POWER UP =1
| BOS Byte Order Select (Not implement)
0: MS byte placed on MD15-8 and LS byte on MD7-0. {32xxx,80x86)
1: MS byte placed on MD7-0 and LS byte on MD15-8. (680x0)
] WTS Word Transfer Sclect

0 byte-wide DMA transfer
1: word-wide DMA transfer

TCR: Transmit Configuration Register (0DH; Type=W in Page0, Type=R in Page2)

Bit |  Symbol _Description
7 - Always |
6 - Always |
5 - Always 1
4 OFST Collision Offset Enable.
3 ATD Auto Transmit Disable.
0: normal operation
1: reception of multicast address hashing to bit 62 disables transmitier,
receplion of multicast address hashing to bit 63 enables transmitter.
2,1 LBI,LBO
LB1 LB0 Mode Remark
U] 0 0 Normal Operation
0 1 1 Internal Lookback
1 0 2 External Lookback
i \ 3 External Lookback
0 CRC The NIC CRC logic comprises a CRC generator for transmitter and a CRC checker for

receiver. This bit controls the activity of the CRC logic. If this bit set, CRC is inhibited by
transmifter. Otherwise CRC is appended by transmitter.

Conditions - | . CRCLogic Activities - |
CRCBIt [ Mode - | CRC Generator] CRC Cheeker |
0 normal enabled enabled
I normal disabled cnabled
0 Joopback enabled disabled
1 loopback disabled enabled

TSR:Transmit Status Register (04H; Type=R in Page()
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This register indicates the status of a packet transmission.

Bit Symbol Desﬁgtlon

7 OwWC Out of Window Collision. It is set when a collision is detected after a slot time (5].2us).
Transmissions are rescheduled as in normat collisions,

6 CDH CD Heartbeat. The NIC watches for a collision signal (i.e. CD Heartbeat signal) during the
first 6.4us of the interframe gap following a transmission. This bit is set if the transceiver
fails 1o send this signal.

5 - Always 1.

4 CRS Carrier Sense tost bit is set when the carrier is lost during transmitting a packet.

3 ABT It indicates the NIC aborted the transmission because of excessive collisions.

2 COL It indicates the fransmission collided with some other station on the network.

1 - Always |

0 PTX This bit indicates the transmission completes with no etrors.

RCR: Receive Configuration Register (0CH; Type=W in Page0, Type=R in Page2)
"Bt | Symbol. S __ Description K

7 - Always 1

6 - Always |

5 MON When monitor mode bit is set, received packers are checked for address match, good CRC
and frame alignment but not buffered 1o memory. Otherwise, packets will be bufTered to
memory.

4 PRO If PRO=1, all packets with physical destination address accepted.

If PRO=0, physical destination address must match the node address programmed in PARO-
5.
k! AM If AM=1, packets with multicast destination address are accepted.
If AM=0, packets with multicast destination address are rejected.
2 AB If AB=!, packets with broadcast destination address are accepted.
If AB=0, packets with broadcast destination address are rejected.
1 AR If AR=1, packets with length fewer than 64 bytes are accepted.
If AR=0), packets with length fewer than 64 bytes are rejected.
0 SEP If SEP=1, packets with receive errors are accepted.

1f SEP=0, packets with receive errors are rejected.

RSR: Receive Status Register (O0CH; Type=R in Page0}

Bit | Symbol Description

7 DFR Defferring. Set when a carrier or g collisian s detected.

6 DIS Receiver Disabled. When the NIC enters the monitor mode, this bit is set and receiver is
disabled. Reset when receiver is enabled after leaving the monitor mode.

5 PHY PHY bit is set when the received packet has a multicast or broadcast destination address. It
is reset when the received packet has a physical destination address.

4 MPA Missed Packet bit is set when the incoming packet can not be accepted by NIC because of a
lack of receive buffer ar if NIC is in monitor mode. Increment CNTR2 tally counter.

3 - Always 1.

2 FAE Frame Alignment Errar bit reflects the incoming packet didn't end on a byte boundary and
CRC did not match at last byte boundary. Increment CNTR( tally counter.

l CRC CRC error bit reflects packet received with CRC error. This bit will also be set for FAE
errors. Increment CNTRI1 tally counter,

0 PRX This bit indicates packet reccived with no errors.

CLDA®, 1: Current Local DMA Registers (01H & 02H; Type=R in Page0)
These two registers can be read to get the current local DMA address.

PSTART: Page Start Register (OUH; Type=W in Page0, Type=R in Page 2)
The Page Start register sets the start page address of the receive buffer ring.
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PSTOP:

BNRY:

TPSR:

TBCRO,1:

NCR:

FIFO:

CRDAO, 1:

RSARO,1:

RBCRO,1:

CNTRO:
CNTRI:
CNTR2:

PARO0-5:

CURR:

MARG-7:

Page Stop Register (02H; Type=W in Page0, Type=R in Page2)

The Page Stop register sets the stop page address of the receive buffer ring. In 8 bit
mode the PSTOP register should not exceed to 0x60, in 16 bit mode the PSTOP
register should not exceed to 0x80.

Boundary Register (03H; Type=R/W in Page0)

This register is used to prevent overwrite of the receive buffer ring. It is typically
used as a pointer indicating the last receive buffer page the host has read.
Transmit Page Start Register (04H; Type=W in Page0)

This register sets the start page address of the packet to the transmitted.

Transmit Byte Count Registers (05H & 06H,;, Type=W in Page0)
These two registers set the byte counts of the packet to be transmitted.

Number of Collisions Register (05H; Type=R in Page0)
The register records the number of collisions a node experiences during a packet
transmission.

First In First Out Register (06H; Type=R in Page0)

This register allows the host ta examine the contents of the FIFQO after loopback.

Current Remote DMA Address registers (08H & 09H; Type=R in Page()
These two registers contain the current address of remote DMA.

Remote Start Address Registers (08H & 09H; Type=W in Page(})
These two registers set the start address of remote DMA.

Remote Byte Count Registers (0AH & 0BH; Type=W in Page0)
These two registers se the data byte counts of remote DMA.

Frame Alignment Error Tally Counter Register (0DH; Type=R in Page0)

CRC Error Tally Counter Register (OEH; Type=R in Page0)

Missed Packet Tally Counter Register (OFH; Type=R in Page0)

Physical Address Registers (01H - 06H; Type=R/W in Pagel)

These registers comtain my Ethernet node address and are used to compare the
destination adderss of incoming packets for acceptation or rejection.

Current Page Register {07H; Type=R/W in Pagel)

This register points to the page address of the first receive buffer page to be used for

a packet reception,

Multicast Address Register (08H - 0FH; Type=R/W in Pagel)
These registers provide filtering bits of multicast addresses hashed by the CRC logic.
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A HTML FILE CODE WEB-PAGE )
i Y/

unsigned char code logo1{s) = {

(047 0%49,0X46,0x38,0439

1§

char cods Htrl_codel} =

*<HTML><HEAD><TITLE>Sign-Advancetech Web Manager</TITLE>"
*¢META htip-equiv=Content-Type content="text/hitml; charset=windows-874'>"
*<META content="Microsoft FrontPage 5.0' name=GENERATOR>"
*</HEAD><FRAMESET border=0 *

*“frameSpacing=0 frameBorder=0 cols=250,">"
'«FRAME name=navigater sic="navigator.htm!' frameBorder=no>"
*<FRAME name=main src="home.htm!' frameBorder=nao>"

*</FRAMESET></HTML>";

char code start]] =
*Please Wait...."

*<meta hitp-equiv="refresh’ content="'5"/>";

char code startlf] =

“Please select the menu to modify Configuration....";

char code navigator(] =

‘<BODY bgColor=#fffftf>\n\t’

*<TABLE height=148 cellPadding=1 width=169 border=0 cellspacing=1 style="border-collapse:
collapse’ bordercolor="#111111">\n\"

"<TBODY><TR>\n\r"

"<TD vAlign=top align=riddle width=51 height=1>\n\"

"<IMG border=0 src='C./SAT5100.JPG' width="150" height='114">\n\¢"
"<FONT></B></TD><TR>\n\r"

*<TD vAlign=top align=middie width=310 height=263 colspan=2>\n\r*

“<B><FONT face=Arial color=#000080 size='2">5AT5100. NET</font></b>\n\t*




‘<BR><FONT face=Anal Helvetica size=-1 >\n\r"

"<BR><A target="main' href="http:/"*/*"ftcpip html'><b><font face=Arial size=2>TCP/IP</A>\n\r
"<BR><A target="main’ href="http:/""/"*fserial html'><b><font face=Arial size=2>Serial Port</A>\n\r"
*<BR><A target='main' href="http:/**/""/input. htm{' ><b><font face=Arial size=2>Input</A>\n\r"
"<BR><A target="main' href="http:/*"/*"/output.html'><b><font face=Arial size=2>Cutput</A>\n\t"
/"<BR><A target="main' href="http:/*"/"*/tech.html'><b><font face=Anal size=2>Tech
Support</A>\n\r"

/1"<BR><A target="rnain' href="http:/**/""/home htrm!'><b><font face=Arial size=2>Home</A>\n\r"
'<BR><BR>\n\t"

<P align=center><FONT color=#218868 size=-1>Select from the menu above to modify
Configuration.\n\r"
"</FONT></P></FONT></FONT></TD></TR></TBODY></TABLE></BODY>\n\r";

char code tepipl] =

*<BODY bgColor=#fttfff>\n\r"

"<TABLE cellPadding=5 border=0 height=1 width=300>\n\r"

*<TD width=501 bgColor=#ddddff height=1>\n's"

"<form method="post'>"

“<P align=left><font color=#000080 face=Arial size=2><B>TCP/IP
CONFIGURATION: </B></font></P>\n\r*

*<TABLFE height='1"><TBODY>\n\r"

*<TR><TD width="275" height="1">\n\r"

“<HR SIZE=1>\n\r"

*<TABLE><TBODY>\n\r"

*<TR><TD width="175"><b><font face=Arial size=2>[P Address :</TD>\n\r*
*<TD width="100"><INPUT type="text’' name=T4 value="' size="13"></TD>\n\"
*<TR><TD width='175"><b><font face=Arial size=2>Port Address :</TD>\n\r"
*<TD width="100"><INPUT type="text' name=T5 value="' size="13'></TD>\n\r"
*<TR><TD width="175"><b><font face=Arial size=2>Subnet Mask :</TD>\n\r"
*<TD width="100"><INPUT type="text' name=T§ value="' size="13"></TD>\n\s"
"<TR><TD width="175"><b><font face=Aral size=2>Gateway Address :</TD>\n\r"
"<TD width="100"><INPUT type="text' name=T7 value="' size="13"></TD>\n\r"
*</TBODY></TABLE>\n\r*

"<HR SIZE=1>\n\r"

“<fTD></TBODY></TABLE>\n\r*




95

*<P align=center><FONT color=#218868 size=-1>Changes will take effect after reboot."
*</FONT><BR><INPUT name=post type=submit valne='Update TCF/IP Settings'></P>\n\r"
"</FORM></TD></TR></TABLE></BODY>\n\r";

char code serial(] =

"<BODY bgColor=#iffft>\n\r"

"<TABLE cellPadding=5 border=0 height=1 width=300>\n\r"
"<TD width=501 bgColor=#ddddif height=1>\n\r"

*<form method="post">\n\r"

‘<P align=left><font color=#000080 face=Arial size=2><B>Port Propertiss:</B></font></P>\n\r"
“<TABLE height='1"><TBODY>\n\r"

*<TR><TD width="275" height="1">\n\r"

“<HR SIZE=1>\n\r"

*<TABLE><TBODY>\n\r"

"<TR><TD width=175><b><font size=2>Bits per second </TD>\n\r"
*<TD width=100><b><gelect size=! name=51>\n\r*
"<option:>38400</option>\n\r"

“<option>19200</option>\n\r"

*<option>9600</option>\n\r"

“<pption>4800</option>\n\r"

*<option>2400</option>\n\r"

“<option:>1200</option>\n\r*

"</select></TD>\n\r"

*<TR><TD width=175><b><font size=2>Data bits :</TD>\n\r"
“<TD width=100><b><select size=1 name=52>"
*<oplion>8</option>\n\r"

"<option>7</option>\n\r"

*</selact></TD>\n\r"

"<TR><TD width=175><b><font size=2>Parity :</TD>\n\r"
*<TD width=100><b><select size=1 name=53>"
“<option>0Ood</option>\nir"

' <ppticn>Event</option>\n\r*

"<pption>None</option>\n\r"

"<fselect></TD>\n\r"

*<TR><TD width=175><b><font size=2>Stop bits :</TD>\n\r"
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"<TD width=100><b><select size=1 name=34>"

*<option> 1</option>\n\r"

*<option>2</option>\n\r"

“</select></TD>\n\r"

"</TBODY></TABLE>\n\r"

"<HR SIZE=1>\n\r"

“<fTD></TBODY></TABLE>\n\r"

"<P glign=center><FONT color=#218868 size=-1>Changes will take effect after reboot.”
"</FONT><BR><INPUT name=post type=submit value='Update Port Settings'></P>\n\s"
"</FORM></TD></TR></TABLE></BODY>\n\r";

char code input(] =

"<BODY bgColor=#fffff>\n\r"

"<TABLE cellPadding=5 border=0 height=1 width=300>\n\r"

*<TD width=501 bgColor=#ddddff height=1>\n\r"

"<FORM><P align=left><font color=#000080 size=2><B>Monitor mode:</B></font></P>\n\r*
*<TABLE height="1'><TBODY>\n\r"

"<TR><TD width="275" height="1">\n\r"

*<HR SIZE=1>\n\r"

"<TABLE><TBODY>\n\r"

"<TD width=229><font size=2>INPUT 1</TD>\n\t"

*<TD><select size=1 multiple style="width:100' name=I1></select></TD><TR>\n\r"
*<TD width=229><font size=2>INPUT 2</TD>\n\r"

*<TD><selact size=1 multiple style="width:100' name=[2></select></TD><TR>\n\t"
"<TD width=229><font size=2>INPUT 3</TD>\n\r"

*<TD><gelect size=1 multiple style="width;100' name=[3></select></TD><TR>\n\r"
*<TD width=229><font size=2>INPUT 4</TD>\n\r"

*<TD><select size=1 multiple style="width:100' name=14></select></TD><TR>\n\r"
/*"<TD width=229><font size=2>INPUT 5</TD>\n\r"

*<TD><select size=1 multiple style='width:100' name=I5></select></TD><TR>\n\r"
*<TD width=229><font size=2>INPUT 6</TD>\n\r"

*<TD><sgglect size=1 multiple style="width:100' name=[6></seloct></TD><TR>\n\r"
“<TD width=229><font size=2>[NPUT 7</TD>\n\r"

“<TD><select size=1 multiple style="width;100' name=I7></select></TD><TR>\n\r"
‘<TD width=229><{ont size=2>INPUT 8</TD>\n\t"
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"<TD><select size=1 multiple style="width:100' name=I8></select></TD><TR>\n\r" */
*</TBODY></TABLE>\n\r"

"<HR SIZE=1></TD>\n\t"

*</TBODY></TABLE>\n\r"

“<P align=center><FONT color=#218868 size=-1>Show effect after input update.*
“</FONT><BR><BR><INPUT name=post type=submit value='Update Input'></P>\n\1"
"</FORM></TD></TR></TABLE>\n\r"

"<meta http-equiv="refresh' content='1'/>"

“</BODY>\n\t",

char code output{] =

*<BODY bgColor=#ffffft>\n\r"

“<TABLE cellPadding=5 border=0 height=1 width=300>\n\r"

*<TD width=501 bgColor=#ddddff height=1>\n\s"

"<FORM mathod="post'><P align=left><font color=#000080 size=2><B>OUTPUT
FUNCTION</B></font></P>\n\r*

*<TABLE height="1"><TBODY>\n\r"

*<TR><TD width="275" height="1">\n'¢"

"<HR SIZE=1>\n\r"

"<TABLE><TBODY>\n\r"

"<TD width=229><font size=Z>QUTPUT 1</TD>\n\1"

*<TD><select size=1 style="width:100' name=01></sslect></TD><TR>\n\r"
"<TD width=229><font size=2>QUTPUT 2</TD>\n\r"

*<TD><select size=1 style="width:100' name=02></select></TD><TR>\n\r"
*<TD width=229><font size=2>0UTPUT 3</TD>\n\r"

*<TD><select; size=1 style='width:100' name=03></select></TD><TR>\n\r"
"< TD width=229><font size=2>0UTPUT 4</TD>\n\"

"<TD><sgelect size=1 style='width'100' name=04></select></TD><TR>\n\r"
**<TD width=229><font 5ize=2>QUTPUT 5</TD>\n\r"

*<TD><select size=1 style="width:100’ name=05></select></TD><TR>\n\r"
"<TD width=228><font size=2>0UTPUT 6</TD>\n\1"

“<TD><select size=1 style="width:100' name=06></select></TD><TR>\n\r"
*<TD width=229><font size=2>0UTPUT 7</TD>\n\r"

*<TD><selact size=1 style="width:100' name=07></select></TD><TR>\n\r*
*<TD width=228><font size=2>0UTPUT B</TD>\n\r"




"<TD><select size=1 style="width:100' name=08></selact></TD><TR>Wn\r"*/
*</TBODY></TABLE>\n\r"

"<HR SIZE=1></TD>\n\¢"

"</TBODY></TABLE>\n\r"

"<P align=center><FONT color=#218868 size=-1>Changes will take effect after output update.\n\r*
"</FONT><BR><BR><INPUT name=post type=submit value='Update Qutput'></P>\n\r"
"</FORM></TD></TR></TABLE></BODY>\n\r";

char code home|] =

"<HTML><HEAD>"

‘<META http-equiv=Content-Type content="text/html: charset=windows-874'>"

*<META content="MSHTML 6.00.2900.2180' name=GENERATOR></HEAD>"

"<BODY>"

"<TABLE cellPadding=5 width=498 border=0>"

‘<TBODY><TR>"

"«th width=484 height=334 align="center' valign="top' nowrap £><TABLE width='435">"
*<TBODY>"

‘<TR >’

"<TD colSpan=2><B><FONT size='2' face=Arial>DEVICE INFORMATION:</FONT></B></TD>"
"<TR><TD width="129" height='20'><font size='2' face="Arial'>Firmware Version :</font></TD>"
“<TD width="245" height="20'><font size="2" face='Arial'>V1.00B02T02.REV.01062006 </font></TD>"
"</TR></TBODY>"

"</TABLE><TABLE width="'300">"

"<TR>"

*<TD colSpan=3><B><FONT size='2" face=Arial>TCP/P</FONT></B></TD>"

“<TBODY>"

*<TD colspan="2"><FONT face=Aria] size=2>IP Address :</FONT></TD>"

"<TD ><font size="2' face="Arial' name="'T4"></font></TD>"

"<JTR><TR>"

*<TD colspan='2"><FONT lace=Arial size=2>Port :</FONT></TD>"

"<TD><font size="2' face="Arial' name="T%"></font></TD>"

"<TR><TR>"

"<TD colspan='2'><FONT face=Arial size=2>8ubnet Mask :</FONT></TD>"

"<TD><font size="2" face='Aral name="T6'></font></TD>"

"<TR><TR>"
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"<TD colspan="2"><FONT face=Arial size=2>Gateway Address :</FONT></TD>"
‘<TD><font size="2" face="Aral' name="T7'></font></TD>"

"</ TR>"

“<TR>"

*<TD colSpan=3><B><FONT size='2' face=Arial>Serial Port</FONT></B></TD>"
"<TR><TD width="158"><FONT face=Arial size=2>Serial status:</FONT></TD>"
"<TD width="04"><lont size='2' face='Arial'>Status</font></TD>"

"<TD><font size=<'2' face="Arial"></font></TD>"

“<fTR><TR>"

"<TD colspan="2'><FONT face=Arial size=2>Bits per second </FONT></TD>"
“<TD><font size="2' face='Arial'>115200</font></TD>"

“</TR><TR>"

*<TD colspan="2'><FONT face=Arial size=2>Data Bits :</FONT></TD>"
*<TD><font size="2' face="Arial' >8</font></TD>"

*</TR><TR>"

“<TD colspan="2'><FONT face=Arial size=2>Parity :</FONT></TD>"
"<TD><font size='2" face='Anal'>None</font></TD>"

"</TR><TR>"

*<TD colspan="2"><FONT face=Arial size=2>Stop Bits </FONT></TD>"
"<TD><fort size='2" face="Arial' >1</lont></TD>"

*<TR><TR>"

‘</TBODY></TABLE></th>"

« /TR

"</TBODY></TABLE>"

“</BODY></HTML>",

#endif
/*n(.- ______________ )“'/

(- END S
e yes




100

Wsunsuesuaalusamuees Network

L SR

- NETWORK-CONTROL.C SR
SN NS NS s/

14 INCLUDE FILE et

JAUnemmre et e )/

#include "T89CEIAC2.H" // INCLUDE FILE AT85C51ED2.H FOR CPU CLASS DESIGN
#include "STDIO.H" // INCLUDE FILE STDIC.H
#include "STRING.H"  // INCLUDE FILE STRING.H COMPILER APPLICATION
#include "DECLAREH" // INCLUDE FILE DECLARE.H
#include "24LC266.H" / INCLUDE FILE SETVALUE H
/{ #inclnde "24LC16.H" // INCLUDE FILE SETVALUE H
#include "SETVALUE H* // INCLUDE FILE SETVALUE.H
#include "SERIAL.H*  // INCLUDE FILE SERIAL.H
#include "RTL8019AS.H" // INCLUDE FILE RTLB019AS.H FOR CHIP INTERFACE DESIGN
#include "RTLSYSTEM.H" // INCLUDE FILE GETPACEET H
#include *ARP.H" /f INCLUDE FILE ARP.H
#include "TCP.H" // INCLUDE FILE TCP.H
#include “UDP.H" # INCLUDE FILE TCP.H
#include “HTTP.H" // INCLUDE FILE HTTEH
#include “ICMP.H* // INCLUDE FILE ICMP.H

Jt"{ ............... }" */
(- START MAIN FROGRAM )
= y'*/

void mainfveid) {

AUXR = 0x0C, #' T8ICH1AC2 CONFIG SELECT ERAM.

{i AUXRE = (x18; /' AT89C5H1ED2 CONFIG SELECT ERAM.
P1 = OxFF; {#f* SET PORT! IS INPUT AND OUTPUT
i1
Init_serdal(}; /" RETURN SERIAL CONFIGULATION TO SET
-
init_rt18019as(); /' ETHERNET SETTING.

-
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Flag_Start? = 1:
Bytes_write = 0; /' SET BYTE WRITE OF ETHERNET DATA TQ 0.
Byies_tead =10; /' SET BYTE READ OF ETHERNET DATA TO 0,

Delay(10); /{' DELAY.
Y =0,
while (1) { /I LOOP ALWAYS.
if {(Bytes_write > 0) { /{' CHECK BYTE WRITE > 0 FROM DATA SERIAL,
Send_packet(}; /' SEND DATA AT RECEIVE FROM SERIAL TO ETHERNET
TCPAP,
H
if (Bytes_read > 0) { /' CHECK BYTE READ > 0 FROM DATA ETHERNET TCP/IP.

for (Y =0, Y < Bytes_read; Y++) { /' |-
printf{"%C", Packet{55+Y]); /' SEND DATA AT RECEIVE FROM ETHERNET TCP/TP
TO SERIAL.

} -l
Bytes_read = 0 /' CLEAR BYTE READ QOF ETHERNET TCP/IP TO 0.
}
Nicint(); /' CHECK NIC OF ETHERNET PACKET.
}
}
e )/
(- DELAY OF MAIN PROGRAM "
[#H e e )/

void Delay(unsigned int Time_count) {

unsigned int j;

do {

for(j=0:j<100;j++)} {} Time_count--;

} while(Time_count > 0);
retum;
}
R )
- END =)
S S e/
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Tusunsumaunumahauees RS-232

f*"( - yos

/~(- FILE NAME  :SERIALH Sadl

/(- LAST UPDATE  : --/02/2007 SN
e )

- DEFINE EXTERN MAIN PROGRAM S
X - e

extern void Init_serial();

/( _—
(- DEFINE INTERNAL DATA OF SERIAL COMMUNICATION A
= ) . Yo/

unsigned int TimeDataSpeed;

ungigned int DataSpeed,

unsigned char DataBits;

unsigned char Parity;
unsigned char StopBits;
unsigned char SerialSet;

char code DataSpeedDefault{] = "9600 5
char code DbitsDefault]] ="8 5
char code ParityDefault{] = "None "
char code StopBitsDefaultl] = "1 "
Al Y
A G INITTAL FUNCTION SERIAL Y
At )
void Init_serial() {
/' READ DATA SERIAL COMMUNICATICN CONFIG FROM EEPROM'
Y=0
RD_Eeprom{0);
RD_Eeprom(1};
for {I = AddEepDataSpeed; | < (AddEepDataSpeed+17); [++) { i -
BufAnay[Y++] = RD_Eeprom(l); /' BEAD DATA SERIAL SPEED
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if (RD_Eeprom(l) == ' '} {BufArraylY] = RD_Eeprom(l); break;} /' CHECK END READ DATA
SERIAL SPEED FROM EEFROM.
Delay(500);
} "\
BufString = BufArray; /' MOVE DATA ARRAY TO DATA
STRING'
I=0;
while {1} {if {*BufSting == "' '} {Datall] = *BufString; break;} Data[l++] = *BufString++;} //' .
DataSpeed = Vali6{Data[0) Data[1), Datal2] Data[3], Data[4],]); /" SET STRING DATA TO VALUE
INTERGER.

DataBits = RD_Esprom{AddEspDhits); /' READ DATA SERIAL DBITS FROM
EEPROM.

Delay(100);

Parity = RD_Eeprom{AddEepParity); /' READ DATA SERIAL PARITY BITS
FROM EEPROM.

Delay(100);

StopBits = RD_Eeprom(AddEepStopBits); /' READ STOP BITS FROM EEPROM.

Delay(100);

/' SET TH1 AND PCON AT FEQUENCY. = 18.432 MHz

if (DataSpeed == 38400}  {TimeDataSpeed = 1; PCON i= (x80; TH1 = 251;} /' CHECK
BOUD RATE 38400.

else if {DataSpeed == 15200){TimeDataSpeed = 1; PCON |= 0x80; TH1 = 246;) /' CHECK
BOUD RATE 185200.

else if (DataSpeed == 9600) {TimeDataSpeed = 1; PCON = (x80; TH1 = 236;} /' CHECK
BOUD RATE 9600.

else if (DataSpeed == 4800) {TimeDataSpead = 100; PCON |= 0x80; TH1 = 216;} /' CHECK
BOUD RATE 4800.

elss if (DataSpeed == 2400) {TimeDataSpeed = 250; PCON |= 0x80; TH! = 176} ' CHECK
BOUD RATE 2400.

else if (DataSpeed == 1200 {TimeDataSpesd = 500; PCON |= (m80; TH1 = 96;} /" CHECK
BOUD RATE 1200.

else if (DataSpeed == 600} {TimeDataSpeed = 750; PCON = 0x00; TH1 = 96;} /' CHECK
BOUD RATE €00.

/' SET SCON AND TMOD

if {{DataBits == '7') && (Parity == 'C")) {SCON = 0x50; TMOD = 0x20; SerialSet = 0x00;}
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else if ((DataBits == '7') &8& (Parity == 'E')) {SCON = 0x50; TMOD = 0x20; SerialSet = 0x01:}

else if ((DataBits == '7') && (Parity == 'N')} {SCON = 0x50; TMOD = 0x20; SerialSet = 0x02;}

else if ((DataBits == '8") && {Parity == '0")) {SCON = (xD0; TMOD = 0x20; SerialSet = 0x03;}

glse if ((DataBits == '8") && (Parity == 'E'}) {SCON = 0xDO; TMOD = 0x20; SerialSet = 0x04;}

else if {{(DataBits == '8") && (Parity == 'N")) {SCON = 0x50; TMOD = 0x20; SerialSet = 0x05;}

/' SET SCON OF STOPBITS

if ((DataBits == '7') && (Parity == 'N') && (StopBits == '2'}) (SCON = 0x60; TMOD = 0x20;
SerialSet = 0x06;)

TRi=1; //' TIMER 1 RUN.

Tl =0; /' SET TI SEND FIRST CHAR OF UART.

retum,

)

/*"{ ye

- APPLICATICNS SEND DATA )"
O — )

char putchar{unsigned char ¢) {
switch (SerialSet) {
case Ox00: /' 7.0
ACC=c;
if (P) ¢ &= Ou7F;
slse ¢ |= OxB0;
break;
case Ox01: //' 7E
ACC = ¢
if {P) ¢ I= 080,
else ¢ &= Ox7F;
break,
case 0x02: //' 7N
¢ = 0x80;
break;
case (x03: //' B0
ACC =¢;
if(P==1)TB8=0;
else TBB = 1;
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break;
case Ox04: //'8E
ACC =¢;
if (P) TB8 = 1;
else TB8 = O;
break;
case Ox05: /' N //- Defualt
i ACC =g
break;
case 006 /' 7N2
¢ = 0x80;
break;
)
SBUF =¢;
while{!TT);
=0 /" CLEAR BIT FLAG T1 O
return (c}; /' MOV DATA TO SERIAL

}

/*"( _______________________________ )u t'(

(- APPLICATIONS RECEIVE DATA )
( oy

void RxdReceive {) interrupt 4 {
ungigned char c;
unsigned int TimeCut;
TimeQut = 0,
if (RI == 1) { // Check Interrupt Rxd receive Data
while (TimeQut++ <= TimeDataSpeed) |
if (RI == 1) {
switch (SerialSet) [
case 0x00: /' 70
ACC = SBUF,
if (P} ¢ = SBUF & Ox7F;
else ¢ = SBUF i DxB0;
break;
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case Ox01; //'7E

ACC = SBUF;
if (P} ¢ = SBUF | 0x80;
alse ¢ = SBUF & OK7F;
break;

case Ox02: //' 7Nl
c = SBUF & Ox7F;
break;

tase 0x03. //' 80
¢ = SBUF;
break:

case 0xD4: //' 8E
¢ = SBUF,;
hreak;

case 0x05: //' 8N

¢ = SBUF;
break;
case Ox06; /' 7N2
¢ = SBUF & Ox7F,
break;
)
AuxData[Bytes_write++] = ¢; #/
Rl ={;
TimeOut = 0;
}
]
)
return;
}
e y
' END
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